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Copyright Notices

Copyright © 1992 - 2003 Vividata, Inc. All Rights Reserved Worldwide.
This manual, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the
terms of the Vividata End-User License Agreement license.

Except as permitted by such license, no part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any language, human or computer, in any form or by any means, electronic, mechanical, recording, or otherwise, without
the prior written permission of Vividata, Inc.

The information in this manual is furnished for informational use only, is subject to change without notice, and should not be construed as
a commitment by Vividata, Inc. Vividata, Inc. assumes no responsibility or liability for any errors or inaccuracies that may appear in this
manual.

OCR Shop XTR is a trademark of Vividata, Inc. All other names are the marks of their respective holders.

Portions of the code and documentation are copyrighted works of ScanSoft Corp. 

Portions of this code use the “libtiff” public domain TIFF support software which has the following copyrights:

Copyright © 1988-1996 Sam Leffler
Copyright © 1991-1996 Silicon Graphics, Inc.

This software is based in part on the work of the Independent JPEG Group.

U.S. Government Provision

If this Software is acquired by or on behalf of a unit or agency of the United States Government this provision applies. This Software:
a) Was developed at private expense, and no part of it was developed with government funds,
b) Is a trade secret of Vividata, Inc. for all purposes of the Freedom of Information Act,
c) Is “commercial computer software” subject to limited utilization as provided in the contract between the vendor and the governmental
entity, and
d) In all respects is proprietary data belonging solely to Vividata, Inc.

For units of the Department of Defense (DoD), this Software is sold only with “Restricted Rights” as that term is defined in the DoD Sup-
plement to the Federal Acquisition Regulations, 52.227-7013 (c)(1)(ii) and:

Use, duplication or disclosure is subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer
Software clause at FAR 52.227-7013. Manufacturer:

Vividata, Inc.

1300 66TH Street
Emeryville, CA 94608
U.S.A.

If this Software was acquired under a GSA Schedule, the U.S. Government has agreed to refrain from changing or removing any insignia
or lettering from the Software or the accompanying written materials that are provided or from producing copies of manuals or disks
(except for backup copies) and:
(e) Title to and ownership of this Software and documentation and any reproductions thereof shall remain with Vividata, Inc.,
(f) Use of the Software and documentation shall be limited to the facility for which it was acquired except under special contract, and:
(g) If use of the Software is discontinued to the installation specified in the purchase/delivery order and the U.S. Government desires to use
it at another location (except under special contract), it may do so giving prior written notice to Vividata, Inc., specifying the type of com-
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puter and the new site. U.S. Government personnel using this Software, other than under DoD contract or GSA Schedule, are herby on
notice that use of this Software is subject to restrictions which are the same as or similar to those specified above.

Request for Comments

In our effort to provide you with the best documentation possible, we welcome
any comments and suggestions you may have about our products. Please direct
communications to us at:

Vividata, Inc.
1300 66TH Street
Emeryville, CA 94608
U.S.A.
Phone: (510) 658-6587
Fax: (510) 658-6597
Toll-free Sales: (800) 704-2640
E-mail: http://www.vividata.com/support_contact.html
World Wide Web: http://www.vividata.com
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Chapter 1: Before You Begin
 OCR Shop XTR Overview

OCR Shop XTR quickly and accurately turns printed pages and faxes into
editable documents that you can use with your favorite programs.

The technology used is Optical Character Recognition (OCR). During OCR,
OCR Shop XTR looks for and defines characters in an image to produce text that
you can revise without retyping. You can export the recognized text from OCR
Shop XTR for use in a wide variety of word processing, page layout, and
spreadsheet programs.
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General description

OCR Shop XTR utilizes Scansoft SDK 5.0 OCR technology to accomplish its
fast and accurate optical character recognition.

OCR stands for optical character recognition: the process of transferring text
from printed pages into a computer file on screen that can be edited— without
retyping.

A scanner is more than a copy machine that simply transfers an image into your
computer. Rather, it translates a page into data by dividing up the image into
millions of dots or bits (usually from 40,000 to 90,000 per square inch) and then
assigns a value to each dot, depending upon whether it is inked, partially inked,
or blank.

The composite document stored in your computer is the map of these dots, that
is, a bitmap. Your computer sees this data not as editable text, but as one
bitmapped image.

OCR then, is the process of translating this bitmap into editable text. Text
characters are designed by assigning a code corresponding to each key on the
keyboard, be it a letter, number or symbol. There are a variety of different code
sets in use, but the most common code set is the ASCII (American Standard Code
for Information Interchange) table of character equivalents. ASCII is generally
recognized as the universal code for most computers. Almost every program that
uses text and/or numbers understands ASCII.

Prior to 1988, matrix-matching, the process by which a bitmap’s shape is
compared to a library of character shapes, was the only method of text
recognition. Because matrix-matching required exact matches, it only worked for
a small number of fonts and sizes. Thus, it was neither widely used nor
recognized as a useful process. This changed when Caere released OmniPage, a
page-recognition program that incorporated OCR technology based on
feature-analysis. Now, the process involved individual character features being
analyzed for recognition rather than matrix-matching for shapes as earlier OCR
had done. Caere was acquired by ScanSoft in 2000 and its technology
incorporated into ScanSoft’s offerings.

Now in OCR Shop XTR, Vividata utilizes Scansoft’s proprietary OCR Engine
technology from the ScanSoft SDK 5.0.
2 - OCR Shop XTR User’s Guide
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Type Conventions

Different kinds of typefaces used throughout this manual indicate text that will
appear on the screen or need to be entered by the user.

When asked to enter commands preceded by a pound sign (‘#’), the user should
be in super-user mode or ‘root’ first. (The command to be entered does not
include the pound sign itself.)

System Requirements

OCR Shop XTR is available for a variety of Unix-based workstations. The
following platforms are currently supported:

If your platform is not listed above, you can contact Vividata, Inc. to see if your
platform has been added since this printing of the manual.

Type: Indicates text is:

courier text generated by the computer

courier bold text typed in by user

<brackets> text to be replaced by user

Manufacturer Operating System / CPU

Sun Solaris SPARC (Solaris 2.7+)

Linux: RedHat, Mandrake, etc. Linux x86 (Kernel 2.0 and higher)

Table 1: Supported Platforms
OCR Shop XTR User’s Guide - 3
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Customer Support

You can reach the Vividata, Inc. technical support staff by:

• Online email form: http://www.vividata.com/support_contact.html

• Fax: USA (510) 658-6597

• Telephone: USA (510) 658-6587

Customer Service is available on regular business days from 8:00 AM to 5:00 PM
(PST/PDT).
4 - OCR Shop XTR User’s Guide



Chapter 2: Software
Installation
Overview

This section describes the installation procedures for OCR Shop XTR, including
the License Manager. Please consult the release notes supplied with the product
for any last-minute information relevant to your particular system.
OCR Shop XTR User’s Guide - 5
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Installing OCR Shop XTR

Installing OCR Shop XTR on your system consists of a few simple steps. You
may have obtained your OCR Shop XTR distribution either from the internet or
from a CD-ROM.  In both cases, you should have a OCR Shop XTR distribution
file called, “<product>-<platform>-<version>”.  The file name will vary
depending on the product name, operating system, release number.

Vividata’s installer is a text-based installer and does not require a graphical
interface or user interaction.

Installing OCR Shop XTR from the Distribution File

• For a CD distribution, mount the CD-ROM.

• As root, change to the directory containing the distribution.  For a CD, this
is the top level directory; for an internet download, it is whereever you saved
the download.

# su (become root)

# cd /mnt/cdrom (or the saved location for a download)

• Run the self-extracting executable:

# ./<product>-<platform>-<version>

You will see output similar to this:

Extracting...

Installing...

Killing currently running licensing and <product>
processes...

Files are installed in /opt/Vividata, approximately 16 MB of space is needed
there.

Installing the License Keys

Vividata normally distributes license keys through the Vividata website or by
email.  The encoded license key string is typically wrapped within a
self-installing shell script.  To install the license key using the self-installing
script, run the script:

# sh vvkey.sh
6 - OCR Shop XTR User’s Guide
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The filename of the script may vary.

The license key will be installed in /opt/Vividata/config/vvlicense.dat.  If you
received a license key on paper, you must manually install it in this file.

Configuring the Environment

Please see “Configuring the Environment” on page 7 for details on setting up
your environment.

Installation Complete

You are now ready to use OCR Shop XTR.

Removing OCR Shop XTR

Should it be necessary to remove OCR Shop XTR from your system, become
root and execute the following commands:

# rm -r <vividata install directory>

Configuring the Environment

Environment Variables

A number of environment variables affect the operation of OCR Shop XTR.
These are normally either unnecessary or set automatically during installation,
but you may want to change their default values if you are customizing your
system. If you would like to check on their settings, you can inspect the wrapper
script(s) in $VV_HOME/bin. An explanation of each environment variable
follows:

VV_HOME is the location where OCR Shop XTR is installed. By
default, /opt/Vividata on Solaris 2.x, and /usr/vividata on all other
systems. It is set by default when the program is executed and need only
be changed if there is some specific reason for doing so.
OCR Shop XTR User’s Guide - 7
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Setting the Environment Variables

You can set the appropriate environment variable(s) in your .cshrc or .profile file.
When the next C or Bourne shell is started, its environment will be automatically
configured for Vividata's environment variables.

You can also add the name of the directory that contains OCR Shop XTR to the
PATH environment variable assignment in your .cshrc or .profile file. This will
allow you to launch the application from any directory.

After modifying your .cshrc or .profile file, logout from the system and then login
again to start your session with the modified initialization files.
8 - OCR Shop XTR User’s Guide
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Overview

In running OCR Shop, there are a number of ways to speed up recognition,
increase accuracy, and streamline OCR workflow. These are covered in the
following topics:

• Running OCR Shop

• Session Settings Files

• Command Line Options

• Improving Speed

• Improving Accuracy

• Legal Documents

• Spreadsheets and Tables

• Foreign-Language and Multilingual Documents

• Scanning Large Jobs

Running OCR Shop

To run OCR Shop using the current settings, simply go to the directory where you
installed OCR Shop and type:

./ocrshop

(If the OCR Shop directory was included in the variable assignment of your
PATH environment, then you may begin running the program from any
directory.)

The graphical user interface will then pop up and the program will ready to be
launched.

Session Settings Files

After you have finished a session with OCR Shop, several files are updated in
order to preserve the current OCR Shop settings. The next time that it is run, OCR
Shop will automatically load the saved session settings, and you may continue
where you left off.
12 - OCR Shop User’s Guide
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Each user who runs OCR Shop will have set of files saved in the user’s home
directory. They will consist of the following:

When OCR Shop first starts up, it checks to see if these files exist in the current
user’s home directory. If it finds them, it loads them into the current session. If
not, it creates them.

Improving Speed

Although OCR Shop is designed to run most efficiently using its automatic
features, in some cases, operating OCR manually can actually speed up your job
completion time. Factors most affecting processing speed in OCR Shop include:

• Computing Power

• Recognition Settings Window Options

• Specific Zones

Improving Accuracy

Typeset, high-quality printed pages return the best recognition accuracy. The
following factors most affect text-recognition accuracy:

• Recognition Settings Window Options

• Line Art

• Document Quality

Table 1: OCR Shop Settings Files
.ocrshop.rc top-level settings (contains the names of the

 .rrc, .brc, .drc, and .trc files to be used)
.ocrshop.rrc OCR settings
 .ocrshop.brc batch scan settings
.ocrshop.drc dictionary file list
.ocrshop.trc training file list

.ocrshop.r.scn OCR scanner settings

.ocrshop.b.scn batch scan scanner settings
.ocrshop.fmt output formats
.ocrshop.prf proofing editors
OCR Shop User’s Guide - 13
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• Scanning Angle

• Scanner Glass Clarity

• Paper Transparency

Recognition Settings Window Options

No single combination of settings always results in the quickest, most accurate
recognition job. However, if you use the settings most appropriate to each
document’s page such as layout, printing, quality, font and size, OCR Shop’s
speed and accuracy will be maximized. (See “The Recognition Settings
Window” on page 67. for details on determining the settings.)

Line Art

OCR Shop may recognize some line-art graphics as text if the artwork is poor and
the lines resemble letter strokes. To avoid OCR Shop incorrectly recognizing art
of this type as text, draw a manual zone around each graphic, and designate the
contents as Graphic under the Zone Contents menu in the Zone Editor Window.

Document Quality

OCR Shop recognizes characters in almost any font from 6 to 72 point although
the following pointers may improve recognition accuracy:

• The print should be as clean and crisp as possible. Characters should be
distinct, separated from each other and not blotched together or overlapping.

• The document should be free of handwritten notes, lines and doodles.
Anything that is not a printed character slows recognition, and any character
distorted by a mark will be unrecognizable.

• Try to avoid highly stylized fonts. For example, OCR Shop may not
recognize the Zapf Chancery font accurately.

• Try to avoid underlined text. Underlining changes the shape of descenders on
the letters q, g, y, p, and j.

Scanning Angle

Make sure that the document is positioned correctly in your scanner and is not
slanted. Even if you place a document in the scanner correctly, it can still shift
enough as the lid is dropped to affect recognition. In such cases, the recognized
text may contain missing characters, split lines of text, or unidentifiable words.
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You may also notice slanted text in the window that appears during recognition
and/or the Zone Editor. If you are scanning a multiple-page document and notice
poor recognition on certain pages, re-scan those specific pages as they were
probably crooked in the scanner.

Scanner Glass Clarity

The sheet of glass on the flatbed of the scanner must be clean and clear. If it gets
dirty, wipe it gently with a soft, damp, lint-free cloth or tissue. Be sure it is
completely dry before you place anything on it.

Paper Transparency

Some paper is so thin that the scanner reads text printed on the back side of the
scanned page. This is often the case with telephone book pages. To correct this
problem, put a black piece of paper between the sheet and the lid of the scanner.

Legal Documents

General Tips

• Many legal documents consist of page-wide text. If this is the case, select
Single Column/Table as the zoning method in the Recognition settings
window.

• It may be necessary to experiment to find the best process for scanning and
saving your specific documents.

Pleading Papers

• Generally, you should select Whole Page as the recognition area in the
Recognition settings window. 

• If numbers on pleading papers are printed less than five spaces from the text,
OCR Shop will consider the numbers to be part of the text body and place
them on the text line. Try drawing a zone around the body of the text to omit
the line and line numbers from the recognition process.

This is also a good option if you are going to add text that will affect the line
numbers. In such cases, use your word-processing application to renumber
each line.

• Experiment on a sample page to find the best process for scanning and saving
OCR Shop User’s Guide - 15
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each document, and then try scanning the entire brief.

Spreadsheets and Tables

The following tips are useful when scanning spreadsheets, charts, tables,
single-column pages, or memos with page-wide text and tabs:

• Select Single Column/Table as the column selection in the Recognition
settings window to preserve the spreadsheet format. When OCR Shop
detects five or more spaces, the Single Column/Table option converts the
spaces to a tab.

• Manually create a zone around a table of numbers and designate the zone
contents as Numeric to improve recognition. You can also make up a new
zone contents files for special characters in your spreadsheet. See “The Zone
Editor Window” on page 89..

Foreign Language and Multilingual Documents

Foreign language and multi-language documents, call for selecting the
appropriate language(s) from the Languages and Dictionaries sections in the
Languages window. OCR Shop utilize all selected entries and the User
Dictionary(ies) selected.

Scanning Large Jobs

You can process a stack of documents through your scanner if you have an
automatic document feeder (ADF). You can choose to recognize every page
immediately or defer recognition until a later time. See “Batch Scan” on page 59.
for more information.
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Overview

The following five tutorials guide the user through OCR Shop’s main functions
and procedures of operation:

• Tutorial 1 — Introduction to OCR Shop, Basic Text Recognition

• Tutorial 2 — Languages, Dictionaries and User Dictionaries

• Tutorial 3 — Deferring OCR with Batch Scans

• Tutorial 4 — Training OCR

• Tutorial 5 — Using the Zone Editor
OCR Shop User’s Guide - 17
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Tutorial 1 — Introduction to OCR Shop, Basic Text Recognition

This tutorial offers a brief introduction to OCR Shop. It contains the following
sections:

• Launching OCR Shop

• What Is Optical Character Recognition (OCR)?

• The OCR Process

• OCR Filename Suffixes

• Scanning the Quick Scan Page Sample

Launching OCR Shop

OCR Shop is started in the same way as other applications on the user’s system.
When it is correctly launched, the user’s display will show the OCR Shop Main
Menu, a window showing six user-accessible buttons as show in Figure 4-1

What Is Optical Character Recognition (OCR)?

Optical Character Recognition (OCR) is the process of converting a text image
file into a text file that a user can edit on screen. OCR is also referred to as text
or page recognition software as it ‘recognizes’ imaged characters and turns them
into type. OCR Shop can use as its source either an image acquired by scanning
a hard-copy document or obtained by loading an image file already stored
somewhere in a format such as a TIFF file.

Figure 4-1  Main Menu and Toolbar
18 - OCR Shop User’s Guide
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In either case, OCR Shop begins with an image that is really just a ‘picture’ of
text and graphics and which cannot be edited directly by the user. The process of
OCR transforms this ‘picture’ into separate characters of text and specific areas
of graphics that can then be altered or edited individually by the user.

From here, the recognized text from OCR Shop can be exported to a variety of
word-processing, page-layout and spreadsheet applications.

The OCR Process

OCR Shop operates in a three-step process by first acquiring an image, then
editing that image into zones and finally recognizing the image. The process
begins by the user accessing the OCR Shop Main Menu which contains both the
menu items and the OCR Shop Toolbar. The first step is to click the Interactive
OCR Shop User’s Guide - 19
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Recognize button on the Toolbar and bring up the OCR Shop Interactive
Recognition window as shown in Figure 4-2

Before the process can begin, the user must decide whether to use the Interactive
Recognition or Automatic Recognition mode. The utility of one or the other is
chosen by clicking on the appropriate button within the OCR Shop Tool Bar.
Each button will bring up the associated window with which the user can
customize the OCR process for each document to be recognized.

After the applicable settings are chosen in either the Interactive Recognition or
the Automatic Recognition windows, the user can then start the process by

Figure 4-2  Interactive Recognition Settings
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clicking on the “Start Recognition” button. Once the scanned document or image
file is recognized, the resulting text is displayed in a Text Editor window. 

If a scanner is used as the source of the image, the document’s text will be ready
to be saved to a file. You can elect to retain all of the scanned images by selecting
"Save Image(s) of Whole Document" in the Document Specification window
(See  “Save Image(s) of Whole Document” on page 86) If you don’t click this
option, none of the scanned images will be retained.

OCR Shop Filename Suffixes

There are several types of files, which you will save, load and edit while using
OCR Shop. By default, OCR Shop adds different suffixes onto your filenames,
depending on their contents and purpose. OCR Shop offers the option to
customize the suffixes but, for these tutorials, you will be using the
predetermined ones specified in OCR Shop.

OCR Shop settings are stored in the following files:

Image files and recognized text files generally have suffixes which reflect the
format in which the image or text is stored. The initial defaults are:

.tif TIFF image file format

.txt ASCII text format

Other settings are stored in files with the following suffixes:

.trn trained character files

.dict user dictionary files

.prf proofing editors

.rc overall settings

.rrc OCR settings

.brc batch scan settings

.drc dictionary file list

.trc training file list

.r.scn OCR scanner settings

.b.scn batch scan scanner settings
OCR Shop User’s Guide - 21
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.zcn zone contents files

.ztm zone template files

Scanning the Quick Scan Page Sample

Scanning this page from the manual (or any simlilar machine-printed document)
will serve as a quick introduction to the OCR process.

1. Place the sample page in your scanner, taking care to align it properly.

2. Select the Recognition Type. For this exercise, click Interactive Recognition
from the Toolbar. The Interactive Recognition settings window will appear.

3. Select Scanner as the Image Source. You can also click on Scanner
Set-up… to do a preview scan and verify that your scanner is connected
properly. (See “The Scanner Set-up Window” on page 75 for more detailed
information on scanner parameters.)

4. Select Whole Page to designate recognition of the entire Page Sample as
one zone.

5. Select Auto Detect Mode for the Column Selection in the Whole Page.

6. Enter temp in the Document name: field. Enter 1 in the Doc. # field, and 1 in
the Page # field. The recognized text file will be saved to the file name:
tempd001p001.txt.

7. Click on the Document Specification… button. The Document Specifica-
tion window will appear.

8. Select Save Image(s) of Whole Document to instruct OCR Shop to save the
scanned document’s image file. The Image Directory, Image Format and
Image Suffix fields will become active.

9. Click on the Image Directory: button to choose a directory for your images.
Its name will appear in the text field. Enter tif as the Image Suffix. The
image file will be saved as: tempd001p001.tif.

10. Click OK to close the Document Specification window.

11. Click Start Recognition. OCR Shop will scan your document and display
the recognized text in a Text Editor window. The text and image files are
saved automatically.
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Tutorial 2 — Languages, Dictionaries and User Dictionaries

Tutorial 2 concerns the user’s choice of languages and dictionaries and the
forming a New User Dictionary to use in the OCR process. Unlike Tutorial 1 in
which OCR Shop’s default settings were used, this tutorial involves changing the
settings in the OCR Shop Options Menu and entering other specific choices. The
areas to be covered are:

• Selecting Languages and Dictionaries from the Languages Menu

• Creating, Saving, and Selecting a New User Dictionary

• Saving Settings into a Settings File

Selecting Languages and Dictionaries from the Languages Menu

An important part of OCR is determining the language to be recognized in the
text image being utilized. by the user. Specific languages can be selected by using
the OCR Shop Options Menu and OCR Shop will know what characters to
expect. For example, if you select German, OCR Shop knows that it will
probably encounter such unique German language characters as an “ß’ or
double-ess. If OCR Shop cannot recognize a letter in a word, it refers to the
dictionary selected by the user and seeks out the letter it needs to create a word
in the finished text.

For this tutorial, you will set up the Languages window for a document
containing English and Spanish.

Selecting Languages

1. Choose Languages… from the Options Menu in the Main Menu. The Lan-
guages window will appear, see Figure 4-3.

2. Select English (US) from the Recognition Languages scrolling menu by
clicking on it. Also click on Spanish to select Spanish. 

3. For practice, click on Swedish. Deselect Swedish by clicking on it again.

Selecting Dictionaries

1. With the Languages window still open, select English (US) from the Dictio-
naries: scrolling menu by clicking on it. Also click on Spanish to select the
Spanish dictionary.
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2. Now that you have selected the appropriate languages and dictionaries,
click OK to close the window.

Creating, Saving and Selecting a New User Dictionary

In many instances, OCR Shop will try to recognize a word or character not
normally included in dictionaries, such as company or product names,
neologisms or coined terms. The OCR Shop Main Menu allows the user to pop
up the OCR Shop Languages window (Figure 5-3) from the Options menu and
add new words to a User Dictionary. OCR Shop can then be set to refer to this
and any other User Dictionary like any other dictionary in the Language window.

For this exercise, you will make a user dictionary for company brochures
repeatedly containing the following unique words:

• Vividata

• ScanShop

• PostShop

• FaxShop

• OCR Shop

Figure 4-3  Languages
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Creating a New User Dictionary

1. Choose User Dictionary… from the Options Menu. The User Dictionary
List window will appear, see Figure 4-4.

2. Click New to create a new dictionary. The Edit User Dictionary window

Figure 4-4  User Dictionary List
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will appear, see Figure 4-5.

3. Click in the Edit/Add text field to activate it, and enter Vividata.

4. Click Add. “Vividata” will appear in the dictionary window.

5. Click in the Edit/Add text field again, and enter ScanShop.

6. Click Add. “ScanShop” will appear in the dictionary window.

7. Repeat for “PostShop”, “FaxShop”, and “OCR Shop”. All five new words
should appear in the dictionary window.

8. .Click   Save as… and enter a file name in the  Save Dictionary As win-
dow by which the new dictionary will be known. The new user-defined dic-
tionary will be saved with the suffix: .dict and will appear in the User
Dictionary List Window. Close this window and return to the OCR Shop
Main Menu. 

Selecting and Deselecting Your Dictionary for Recognition

When a new User Dictionary is created and saved, it automatically appears in the
User Dictionary List Window indicating which dictionaries will be used when

Figure 4-5  Edit User Dictionary
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recognizing images. Among the list, the user can select or de-select User
Dictionaries for running an OCR process.

For this exercise, since your new dictionary is already listed in the User
Dictionary List, you will first bring it back for the next recognition process.

1. If you closed the User Dictionary List window from the last exercise, go to
the OCR Shop Main Menu, choose User Dictionary… from the Options
Menu. You should see your new dictionary listed. 

2. Select it, if it is not already selected, by clicking on it.

3. Click Remove. Your dictionary will disappear from the window, and there-
fore will not be used for the next recognition process.

4. Now click Add… to re-select your user dictionary.

5. Verify that the correct directory is being displayed in the file selection box,
and then select your dictionary from the Add Dictionary to List window by
clicking on its filename.

6. Click OK to load the selected dictionary. Your dictionary will appear in the
User Dictionary List window, and will be used for the next recognition pro-
cess.

7. Click OK to close the User Dictionary List.

Saving Settings into a Settings File

In future OCR sessions, the user can load and apply customized combinations of
language dictionaries and User Dictionaries by having saved them previously. In
this way, a specific combination can be quickly used without re-selecting items
all over again. Since you have just set the Languages and User Dictionary
windows, you will now save them.

1. Choose Save Settings As… from the File Menu in the OCR Shop Main
Menu.

2. Enter the filename of your choice in the Selection field.

3. Click OK. This file will be saved with the suffix: .rc. At the same time, sev-
eral other settings files will be created with the suffixes given above. How-
ever, you need only load and save settings to your filename with the .rc
suffix. This settings file references the others.

4. Your new settings file is available to be reloaded at any time using the Load
Settings menu command.
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Tutorial 3 — Deferring OCR with Batch Scans

There may be occasions when it is not possible to process image files right away
and recognition must be deferred to a later time. OCR Shop enables the user to
retrieve these files from a Batch Scan for a subsequent recognition and training
session. If the available scanner does not have an Auto Document Feeder (ADF),
each page will have to be loaded individually. This section contains:

• The Batch Scan Window

• Setting Up a Batch Scan
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The Batch Scan Window

By clicking on Batch Scan from the Toolbar within the OCR Main Menu, the
OCR Shop Batch Scan window (Figure 4-6) will appear from which selections
can be made allowing documents to be scanned and saved for future use.

Setting Up a Batch Scan

The Batch Scan can be demonstrated by using the sample documents included. 

Figure 4-6  Batch Scan
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1. If your scanner has an ADF, place the Batch Scan Sample Documents in
your scanner’s document feeder, ensuring that they are aligned properly. If
your scanner does not have an ADF, place a single document on the scan
bed, in preparation for scanning.

2. Click Batch Scan from the Toolbar. The Batch Scan window will appear.

3. Enter temp in the Image Filename: field.

4. Enter a directory name in the Image Directory: text field.

5. Select TIFF as the Image Format.

6. Enter tif in the Image Suffix: field.

7. Enter a 2 in the Doc # field and a 1 in the Page # fields. 

8. Select Auto Document Feeder, if your scanner has one.

9. Select letter for the Doc Size: field.

10. You can leave the BPP: and DPI: fields set to their defaults.

11. Click Start Scan. Your image files will be saved beginning with the file-
name: tempd002p001.tif.

Note: If you do not have an ADF on your scanner, you will be prompted to 
load each page.
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Tutorial 4 — Training OCR

Many times scanned images will encounter characters that were scanned or saved
incompletely or even imperfectly. In these cases, a standardized character
(usually the tilde’~’) is used to indicate items not recognized. This exercise
involves the following:

• Loading an Image File for a Training Session

• Training OCR Shop

• Saving a Training File

Loading an Image File for a Training Session

OCR Shop creates a Trained Character File to produce a complete set of
characters from an image or scan that included some it could not recognize. By
going to the OCR Main Menu and clicking on the Training Session button from
the Toolbar, a modified Recognition window entitled “Training” (Figure 4-7)
will appear with which the user can load deferred recognition files from the last
Batch Scan tutorial.

Note: Use of a trained character file (or files) is ideal when there are unusual
or difficult-to-read characters throughout the document. A trained character
file then helps OCR Shop recognize these characters with greater accuracy.
However, for most documents, use of a trained character file is not necessary
and may even slow the recognition process down.
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1. Click Training Session from the Toolbar. The Training window will appear.

2. Select File(s)… as the image source to load the images from the Batch Scan
tutorial. The Select Image Files window will appear, see Figure 4-8.

Figure 4-7  Training
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3. Verify that the correct directory is being displayed in the file selection box,

and then double-click on the file, tempd001p001.tif (from Tutorial 1) under
Files:. The selected file will appear in the Selected file(s): scrolling menu.

4. Click OK to close this window and return you to the Training window.

5. Note that Whole Page is selected automatically. Select Auto Detect Mode
for the Column Selection.

6. Click Start Recognition. OCR Shop will scan the image file, and then the
Train Characters window will appear, see Figure 4-9. You are now ready to

Figure 4-8  Select Image Files
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train OCR Shop.

Note: The characters you see in the Train Characters window may vary 
depending on your scanner, see Figure 4-9.

Training OCR Shop

OCR Shop displays each character image it recognized as well as those it rejected
in the Train Characters window. Recognized characters appear first, with OCR
Shop’s attempted identification appearing underneath each character or symbol
image. Unrecognized characters are indicated with a tilde, “~”, and are listed at
the end. You can scroll through the Train Characters window, making corrections
and/or additions — thereby “training” OCR Shop, in order to increase
recognition accuracy. 

Figure 4-9  Train Characters
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1. If you have not completed the first part of this exercise, “Loading an Image
File for a Training Session,” do so now. You should have the Train Charac-
ters window on your screen. 

2. Scroll through the list and note which were recognized correctly, recognized
incorrectly, and rejected. 

3. Click on the first incorrectly recognized or rejected character. then, click
Specify… and the Specify Character window will appear as shown in
Figure 4-10. The character will be displayed, along with OCR Shop’s best
guess as to what the character is, as shown in the   Characters: text field.
Alternatively, by double-clicking on the character, the user can call up the
Specify Character window

Note: You can only specify one character at a time. 

4. Correct the character specification either by going to the Extended ASCII
scrolling menu and double-clicking on the correct character, or by directly
typing the correct character(s) into the Character(s): text field.

5. Click OK to accept the new character specification and close the window.

6. Repeat steps 4-6 until you have trained all necessary characters that were
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incorrectly recognized or rejected characters.

Saving a Training File

OCR Shop saves a file of characters processed through the Train Characters as a
Trained Characters file which can reloaded in the future for recognition of similar
documents. An example of this would be documents with the same font or from
the same source.

1. If you have not completed the first two parts of this exercise, “Loading an
Image File for a Training Session” and “Training OCR Shop,” do so now.

2. Click Save….

3. Enter a filename for your new training file, and click OK. Your file will be
saved with the suffix .trn and will be available to add to the Trained Charac-
ter Sets window under the Options Menu. (see “Trained Character Settings”
on page 50).

Figure 4-10  Specify Character
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Tutorial 5 — Using the Zone Editor

Often OCR Shop is presented with an image that includes text but also graphics
that may not be desired such as graphs or pictures. The Zone Editor allows the
user to disregard these areas and concentrate on specific areas of text for
recognition. To accomplish this, the Zone Editor window (Figure 4-11) appears
during Interactive Recognition for Specific or Automatic Zones and during
Automatic Recognition for Specific Zones. This section contains:

• Using the Zone Editor

• Creating a Zone Template

• Completing Recognition

Working with the Zone Editor

OCR Shop provides complete control over which sections of text image are to be
recognized in a number of ways. The User can specify the order in which these
sections are processed as well as indicate what the possible contents of the zones
might be. Examples include contents that are text and numbers, numbers only,
graphics or custom character sets.

Interactive Recognition specifies zones ‘on the fly’, in which the zone editor is
popped up as each new image is scanned or loaded. Automatic Recognition sets
a group of zones once and the same zone template is used for all images. The
Zone Editor tutorial will use the Interactive Recognition to specify the zones.
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You will need the image file from Tutorial 1, tempd001p001.tif.

Figure 4-11  Zone Editor
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Accessing the Zone Editor

1. Click Interactive Recognition from the Toolbar. The Interactive Recognition
window will appear.

2. Choose File(s) as the Image Source. The Select Image Files window will
appear.

3. Verify that the correct directory is being displayed in the file selection box,
and then double-click on tempd001p001.tif. under Files:. It should appear in
the Selected file(s): scrolling menu. If there are any other files in the
Selected file(s): menu, select them by clicking on them, and click Cut.

4. Click OK. The Recognition window will reappear.

5. Select Specific Zones as the Area to Recognize.

6. Select AutoDetect Mode as the Column Selection.

7. Enter a 3 in the Doc #: field and a 1 in the Page #: field. The files’ names
will be saved as: tempd003p001.txt.

8. Click Start Recognition. After scanning the image file, the Zone Editor win-
dow will appear with the scanned image displayed in the background.

Creating Zones

Create zones by click-draging on the portions of the the scanned image in the
order in which you want zones to be recognized. Each zone appears labeled in
numeric order with its character type defaulted to alpha-numericand its column
selection defaulted to the “Auto Detect Mode”. Zones are delimited by borders
that can be modified with grab-bars which appear when the zone is selected. As
many zones as can fit within the scaned image can be created. Each zone is
moved around by click-dragging within the limits of other neighboring zones.

Renumbering Zones

1. Select “Number Mode” (all number counts will be removed)

2. Begin clicking within zones in the order you wish them to be recognized.
They will be numbered as you select them.

3. When you have selected the final zone, the mode will revert to “Draw
Mode”
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Deleting Zones

1. Select “Delete” mode

2. Click within a current zone to delete it 

3. Click on the “Draw” button to create more zones.

Selecting Columns

1. To change from Auto Detect Mode when doing recgnition of text with col-
umns, choose other options under Column Selection.

2. Choose Single Column/Table for more specialized recogniton

3. For more customization, choose No Parsing or Multiple Columns which can
be set for from two to nine columns

Changing Zone Contents

1. To change a given zone’s contents, select it and then change the value of the
“Zone Contents” option menu.

2. To change from the default of both Alpha and Numeric type characters,
select from the Zone Contents option menu either Alpha or Numeric types
as well as either Graphics or Custom character selection. 

3. Select Custom from the option menu to list specific ASCII characters and
apply them to the current scanned image or save them to be loaded later.
The customized list can be cleared or saved to a “Zone Contents File” in a
designated directory as a named file with the suffix “ .zcn”.

Creating a Zone File

In some cases, you will want to save the zone locations and contents for future
recognition processes. You can save them in the form of a template by creating a
Zone File.

1. If you have not completed the previous exercises in this tutorial, do so now.

2. Choose Save Zone File As… from the File menu. The Save Zone File win-
dow will appear.

3. Enter a filename in the Selection field.

4. Click OK. Your Zone File will be saved with the suffix .ztm to the desig-
nated directory and will become the new default zone set.
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Completing recognition

Once you have set the zones and saved the template, click Continue, and OCR
Shop will finish the recognition process and generate the text in the Text Editor.
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Overview

There are three main components of the OCR Shop Main Menu:

• The File Menu

• The Options Menu

• The Help Menu
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The File Menu

The File Menu lets you manage OCR Shop settings files.through specific
commands and they include:

• Load Settings…

• Save Settings

• Save Settings As…

• Exit

Load Settings…

Choose Load Settings… from the File Menu to load previously saved settings.
These settings can include combined settings for recognition, languages, user
dictionaries, trained character lists, scanners, and other preferences saved by the
user.

Loading User Settings

1. Choose Load Settings… from the File Menu. The Load Settings window
will appear. See Figure 5-2

2. Verify that the correct directory is being displayed. Then, select the desired
settings file by clicking on it, or by directly typing in its name.

3. Click OK.

Figure 5-1  Main Menu
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Save Settings / Save Settings As…

Choose Save Settings As… to save the current OCR Shop settings under a new
name for later use. This is especially useful if there are settings particular to
particular documents or to particular scanners.

The default main settings file suffix is: .rc.

1. Choose Save Settings… from the File Menu. The Save Settings window
will appear.

2. Enter the new settings file name.

3. Click OK.

Figure 5-2  Load Settings File
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Selecting Save Settings will save the current settings to the filename that was last
loaded from or saved to.

Exit

Choose Exit to quit the OCR Shop program.

The Options Menu

Various options can be used to specify the parameters needed to control the OCR
Shop process and they include:

• Languages

• User Dictionary

• Trained Character Settings

• Proofing Editor Options

• Recognition Options

• Output Format Editor

Languages

Choose Languages… to select one or more language character sets and
dictionaries for text recognition. OCR Shop uses your selection from the
Languages scrolling menu to identify unique characters to a particular language.
It uses your selection from the Dictionaries scrolling menu to improve the
accuracy of identifying characters within complete words.

For example, if you choose English under Languages, foreign characters such as
“ü” and “å” would likely be mis-identified as “u” and “a”.

At the same time, a specific selection under Dictionaries   can aid OCR Shop
in determining a problematic character. For instance, choosing the English
dictionary can help determine the choice of either an “f'” or a “t” if the two
previous characters are “ca”. Within the dictionary, “cat' is listed while “caf” is
not and therefore the character in question must be a “t”.

More than one language and/or dictionary can be selected at a time but, for faster
recognition, use only the minimum necessary number of selections.
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Selecting a Language and Dictionary

1. Choose Languages… from the Options Menu. The Languages window will
appear, see Figure 5-3.

2. Click once on a language to select it. To deselect a language, click on it
again. Select as many languages as are appropriate. 

3. Click once on a dictionary to select it. To deselect a dictionary, click on it
again. Select as many dictionaries as are appropriate. 

4. Click on the appropriate selection boxes depending on if you want OCR
Shop to Ignore Acronyms, Ignore Abbreviations and/or Ignore Proper
Nouns.

5. Click OK.

User Dictionary

Choose User Dictionary… to create, edit or delete a user dictionary. User
Dictionaries allow you to teach OCR Shop unique words that may appear
repeatedly in your documents. For example, you may want to create a User
Dictionary for all of your company’s product names, so OCR Shop will
recognize them as complete words.

Figure 5-3  Languages
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Once user dictionaries have been created, they can easily be selected for use with
future OCR Shop documents and called back from the User Dictionary List in
the next recognition process. 

User dictionaries are saved with the suffix: .dict.

Creating a User Dictionary

1. Choose User Dictionary… from the Options Menu. The User Dictionary
List will appear as shown, see Figure 5-4. The scrolling list contains all user
dictionary files in the directory.

2. Click New. The Edit User Dictionary window will appear, see Figure 5-5.

3. Enter the first word you would like to add to the dictionary in the Edit/Add
text field.

4. Click Add.

5. Repeat Steps 3-4 until you have completed your new user dictionary.

6. Click Save As…, and enter a filename in the Save Dictionary As window. 

7. Click OK to save the dictionary. Your new user dictionary will appear in the
User Dictionary List.

See “Editing a User Dictionary” on page 49. for an explanation of commands 
within the Edit User Dictionary window.

Figure 5-4  User Dictionary List
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Adding an Existing Dictionary to the User Dictionary List

1. Choose User Dictionary… from the Options Menu. The User Dictionary
List will appear; see Figure 5-4.

2. Click Add….

3. Select a dictionary from the Add Dictionary to List window.

4. Click OK. The added dictionary will appear in the User Dictionary List.

Editing a User Dictionary

1. Choose User Dictionary… from the Options Menu. The User Dictionary
List will appear; see Figure 5-4.

2. Select the dictionary you would like to edit by clicking on it, and click Edit.
The Edit User Dictionary window will appear.

Figure 5-5  Edit User Dictionary
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3. To add a new word, enter it in the Edit/Add text field, and click Add.

4. To replace a word already in the dictionary, select it by clicking on it. Enter
the replacement word in the Edit/Add text field, and click Replace.

5. To delete a word in the dictionary, select it by clicking on it, and click
Delete.

6. To include all of the words from another user dictionary, click Merge In…
and enter the filename of the dictionary you wish to load in. Click OK.

7. Once you have made all necessary changes, click Save As….

Removing a User Dictionary from the list

1. Choose User Dictionary… from the Options Menu. The User Dictionary
List will appear; see Figure 5-4.

2. Select the dictionary you want to remove by clicking on it.

3. Click Remove.

Trained Character Settings 

OCR Shop allows the user to add, edit and delete training files by selecting sets
through the Options Menu. (See “Training Session” on page 85 for information
on training OCR Shop and saving training files.) Whichever training files are
currently in the Training Files window will be used in the next recognition
process.

Training files are saved with the suffix: .trn.

Adding Trained Character Sets 

1. Choose Trained Character Sets… from the Options Menu. The Trained
Character Sets window will appear; see Figure 5-6

2. Click Add….

3. Select the training file you want to add from the Add Training File to List
window.

4. Click OK. The added file will appear on the Training Files list.
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Editing Trained Character Sets

1. Choose Trained Character Sets… from the Options Menu. The Trained
Character Sets window will appear.

2. Select the training file you want to edit by clicking on it. 

3. Click Edit.

Please see “The Train Characters Window” on page 99 for detailed 
information on editing trained character sets.

Removing Trained Character Sets

1. Choose Trained Character Sets… from the Options Menu. The Trained
Character sets window will appear.

2. Select the training file you want to remove by clicking on it.

3. Click Remove.

Figure 5-6  Trained Character Sets
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Proofing Editor Options

The Proofing Editor dialog allows you to set the character used as the reject
character in recognition as well as the editor to be used for editing the recognized
text. 

The default reject character is '~'. This character will appear in the recognized
text when OCR Shop has a low confidence in the recognition of a character or
section of text.

The proofing editor list gives a number of different applications which can be
used to view the recognized text. The user can select among those listed or add
their own editor. When editing an entry or creating a new one, the command
entered should assume that the filename to be viewed will be appended to the
command. In the case that the filename is not the last item of the command line,
the user can create a shell script which will place the filename in the correct spot
for the command. An example of this can be found in the netremote script, which
allows the user to use Netscape as the proofing editor, loading the recognized file
into an existing session of Netscape if one is running or invoking a new instance
if one is not. This example script can be found in the bin directory in the
installation.

Figure 5-7  Proofing Editor Opttions
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Recognition Options

Choose Recognition Options… to set the default recognition settings. See
Figure 5-8.

Recognition Mode

The OCR Shop Recognition Options windows lists three recognition modes
including 3D OCR, Any Page, or Binary The fastest recognition mode is the
Binary mode, but is best utilized when processing high-contrast documents
where characters are distinct and sharp. The AnyPage mode allows for varying
background shades in a document. 3D OCR mode is the most versatile of the
three modes and, while occasionally a bit slower, can handle very difficult
documents, such as multi-generational photocopies, documents with very small
type, and images with a variety of color shades.

Document Type

Select the desired document type: Fully Formed Characters, Dot Matrix Printed,
or AutoDetect.

Figure 5-8  Recognition Options
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Orientation

OCR Shop makes recognition easier by specify whether or not to rotate images
to be processed. While the default setting is o” (no rotation), rotation can be done
automatically by choosing AutoRotate or accomplished manually by selecting
0°, 90°, 180°, or 270°.

Lexical Assist

If Lexical Assist not selected, OCR Shop will refer only to the selected
languages. But if Lexical Assist is enabled, OCR Shop will refer to both
the specifically selected languages and dictionaries in the Languages window
during recognition.

Ouput Format Editor

The Ouput Format Editor dialog (see Figure 5-9 below.) allows you to select
which formats among the possible output formats will appear in the Text Format
menu in the Document Specification dialog. By default there will be
approximately 20 formats.  You may select and unselect any of the items. The
maximum number of formats which can be selected is 40. Any more will be
ignored. 
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The Help Menu

On-Line Help and the OCR Shop Manual

The manual for OCR Shop is only available with Netscape (VVNET set).
On-Line Help however, will either work with vvhelp or Netscape if VVNET is
set.

Product Information

Choose Product Information for software version numbers and detailed
information about Vividata contacts and tech support.

Figure 5-9  Output Format Editor
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Show Activity Log

Choose Show Activity Log… to display a listing of all jobs, actions and
operations completed in OCR Shop. The Activity Log window can be closed by
clicking Dismiss.
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Overview

This chapter covers the functions of each of the buttons on the Toolbar:

• Interactive Recognition

• Automatic Recognition

• Batch Scan

• Training Session

• Proofing Editor

• Image Viewer
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The Toolbar

Interactive Recognition

Choosing Interactive Recognition calls up the Interactive Recognition window,
where you may adjust any or all of the recognition settings and options, and then
begin scanning or loading of images for recognition. The output text will be
saved to the filename that you specify, as well as the original scanned images, if
so selected.

If Specific Zones or Automatic Zones has been selected, the Zone Editor will be
called up after each image is scanned or loaded in, so that you may specify which
zones to use for recognition.

See “The Recognition Settings Window” on page 67. for more details on
recognition settings.

Automatic Recognition

Choosing Automatic Recognition calls up the Automatic Recognition window,
where you may adjust any or all of the recognition settings and options, before
scanning or loading of images for recognition. As with Interactive Recognition.
the output text will also be saved to the filename specified, and any original
scanned images will be saved if so selected.

Figure 6-1  Toolbar
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If you have several documents to recognize such as business forms, all of which
are to be processed with the same set of zones, then you may want to use Specific
Zones. Selecting Specific Zones... will call up the Zone Editor, so that you can
specify the desired zones to be used in recognition.

If you are using images from your scanner, and if your scanner does not have an
Automatic Document Feeder (ADF), Automatic Recognition will pause after
each page is recognized, so that the next page can be loaded. 

See “The Recognition Settings Window” on page 67. for more details on
recognition settings.

Batch Scan

Choosing Batch Scan allows you to scan multiple pages and defer their
recognition to a later time. The Batch Scan window has two main areas: on the
left side, you choose the filename or names under which OCR Shop will save the
images; on the right side, you can view the scanned images as they are
completed. See Figure 6-2. Later, when you want to recognize the batch scanned
image files, you can easily load them in the Image Source field in either the
Interactive or Automatic Recognition windows.

Batch scan filenames have the following format: 

image_filenamedXXXpYYY.image_suffix

where “XXX” indicates the document number, and “YYY” indicates the page
number. The page number is only used if Use Page Numbers is selected.

So, if the Image Filename is set to “goodboy”, the Doc # is “1”, the Page # is “2”,
the Image Suffix is “.tif”, and Use Page Numbers is selected, then the next image
scanned will be saved to the filename “goodboyd001p002.tif”. If Use Page
Numbers is not selected, then the filename will be “goodboyd001.tif”.
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Image Filename(s)

Enter the base filename with which you want the image files to be saved. 

Image Directory

Enter the name of the directory in which you want the image files saved; or, click
on the Image Directory: button to load a directory name.

Figure 6-2  Batch Scan
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Image Format

Select the appropriate image format from the pull-down menu.

Select Multi-page TIFF file if you selected TIFF, and if you want all the images
saved into a single file.

Image Suffix

Enter an appropriate image file suffix. This field will is set automatically each
time a new Image Format is selected.

Image ID

Enter the document number and page number of your choice in the Doc # and
Page # fields, respectively.

Grouping

Select Use Page Numbers if you want filenames to include the page number.
Note that when page numbers are used, scanning multiple images will cause the
page number for each new image to increase by one, with the document number
remaining constant. The document number will only be incremented if Blank
Page is Document Separator has been selected and a new document is indicated.

Select Double-sided Document(s), if your documents are double-sided. If you
have a single sided scanner (i.e. a "simplex" scanner) OCR Shop will process the
entire batch of pages in the ADF and then prompt you to turn the batch over and
place it back into the ADF so that the reverse sides can be processed. OCR Shop
will track the number of pages, so that in the final document, all pages will be in
the correct order. The  Double sided documents option is only available when
Use Page Numbers is selected.

As an example, if you have four double-sided documents, where the first page is
numbered 1 on the front and 2 on the back, and the second page is numbered 3
on the front and 4 on the back, and so on, then the first pass will scan pages 1, 3,
5, and 7, while the second will scan pages 8, 6, 4, and 2. The end result will be a
single document with all pages in the correct order.

If you have a double sided scanner (i.e. a "duplex" scanner) OCR Shop will
process both sides of the entire batch of pages in the ADF.

If Blank Page is Document Separator is selected, then whenever OCR Shop
encounters a blank sheet of paper in the ADF, it will increment the document
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number, and reset the page number to one. In this way, a whole stack of
documents, each consisting of many pages, could be scanned as one batch. You
would simply slip a blank piece of paper in between each document. Again, this
option is only available if Use Page Numbers is selected. 

Overwrite File Protection

Select Overwrite File Protection if you want OCR Shop to notify you whenever
OCR Shop tries to write over a filename which already exists.

Select Show Last Image if you want OCR Shop to display each scanned image
in the preview window.

Scanner Set-up

Click Scanner Set-up to call up the Scanner Set-up window.

Document Size

Select the appropriate document size from the given list.

BPP

Select the appropriate bits per pixel dimension from the given list.

DPI

Select the appropriate dots per inch from the given list.

ADF

Select ADF if your scanner has an automatic document feeder (ADF) and you
want to enable its use.

Note: If you do not have an ADF, you will be prompted to feed each page 
into the scanner one-at-a-time.

Start Scan Button

Once you have set all the parameters for the batch scan, click Start Scan. 
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Dismiss Button

To return to the Main Menu and Toolbar, click Dismiss.

Training Session

Choosing Training Session calls up the Training window, where you may create
a trained character file from a scanned or loaded image.

A trained character file is a set of pre-recognized text characters from a scanned
image, to which OCR Shop refers when recognizing text. If you have several
documents from the same source, creating a training file helps OCR Shop
identify potentially difficult characters that appear throughout the text.

When you conduct a training session, OCR Shop scans the image and displays
each character image it recognized, as well as those it rejected. All unrecognized
characters are indicated with the default reject character -- usually, a tilde, “~”.
(See “Proofing Editor Options” on page 52. for information on changing the
default reject character symbol.) You may then scroll through the Train
Characters window, making corrections and/or additions, thereby “training”
OCR Shop to increase recognition accuracy. The file of trained characters are
saved as a trained characters file, with the suffix: .trn. 

Once you save the training file, you can reload it for faster recognition of similar
documents, such as those using the same font or from the same source. (See
“Trained Character Settings” on page 50. for more information on using trained
character sets.)

Note: Use of a trained character file (or files) is ideal when there are unusual 
or difficult-to-read characters throughout the document. A trained character 
file then helps OCR Shop recognize these characters with greater accuracy. 
However, for most documents, use of a trained character file is not necessary 
and may even slow the recognition process down.

Creating a Trained Character File

1. Click Training Session from the Toolbar. The Training window will appear.

2. Select the appropriate Image Source. OCR Shop automatically selects
Whole Page.

3. Select the appropriate Column Selection.
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4. Select Retain Formatting, if desired.

5. Click Start Recognition. Once OCR Shop has looked through the image file
or scanned document, the Train Characters window will appear, containing
both recognized and rejected characters. A sample Train Characters window
will appear. See Figure 6-3.

You may now correct any erroneous symbol assignments and save the trained
character file. See “The Train Characters Window” on page 99. for further
details.

Editing an Existing Trained Character File

To modify a trained character file which has already been created, use the Trained
Character Sets window from the Options menu to Add the trained character file

Figure 6-3  Train Characters
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to the list. Then, click Edit to call up the Train Characters window. See “The
Train Characters Window” on page 99. for more details on editing a training file.

Proofing Editor

Clicking Proofing Editor calls up the most recently recognized text in Text
Editor. From the Text Editor window, you can load other recognized documents
for viewing and editing.

Image Viewer

Clicking Image Viewer will call up the most recently scanned image in Image
Viewer. From the Image Viewer window, you can load other images for viewing
and editing.
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Overview

OCR Shop offers precise control through the Recognition settings window which
appears once you have selected either Interactive or Automatic Recognition. The
various aspects of this process control include:.

• Image Source

• Area to Recognize

• Column Selection

• Document Selection

• Start Recognition button

• Dismiss button
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The Recognition Settings Window

Image Source

OCR Shop obtains images for recognition from two sources

• Previously saved file(s)

• Scanner-produced images

Figure 7-1  Recognition Settings
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Processing Previously Saved Files

1. Select File(s)... to load a previously saved image for OCR. The Select Image
Files window will appear, See Figure 7-2.

2. After choosing the directory, click on the desired file name under Files:, and
then click Select or, simply double-click the filename. The selected file will
appear in the Selected File(s): scrolling menu. If you want to select all files,
click All.

3. If you want to delete a file from the Selected File(s): menu, select it by
clicking on it, and click Cut. If you want to undo the cut, click Paste. You
can also insert the filename at a different location (or locations) in the list by
clicking on the filename above which you want the filename that was just
Cut to appear, and then clicking Paste.

4. Once all the image files you would like to recognize are selected by putting
them in the Selected File(s): menu window, click OK. The Recognition set-
tings window will reappear.
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Processing Images from a Scanner

Select Scanner to obtain a new image from your scanner for OCR. Click Scanner
Set-up to make adjustments or changes to the scanner set-up. (See “Chapter 8:
The Scanner Set-up Window” on page 75 for details.)

In the Image Source area, there is also a Document Size pull-down menu with the
most common paper sizes for scanning. The options will vary depending on your
selected scanner. Underneath this menu is a DPI menu, with the most common

Figure 7-2  Select Image Files
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DPI selections for your particular scanner. For complete menus of document size
and DPI available with your scanner, click on Scanner Set-up.

If the scanner has an auto-document feeder, select ADF to use it in the
recognition process.

Area to Recognize

OCR Shop controls the area to be recognized with three options:

• Whole Page

• Specific Zones

• Automatic Zones

Whole Page

Select Whole Page if you want OCR Shop to recognize the entire page area.
Regions containing text will be parsed and recognized, while graphics regions
will be saved into separate image files, if so specified in the Document
Specification window. (See “Auto Save Graphic Blocks” on page 86.).

Note: During a Training Session, this is the only option available.

Specific Zones

Select Specific Zones if you want OCR Shop to recognize only the zones you
draw yourself in the Zone Editor window. This option is best for documents with
complex page layout and/or multiple graphics. It allows you to choose specific
areas to recognize as well as help OCR Shop distinguish the different text areas.
(See “The Zone Editor Window” on page 89. for more information on using the
Zone Editor.)

Automatic Zones

Select Automatic Zones if OCR Shop is to recognize specific zones, but without
the zones being chosen by the user. Once OCR Shop has divided the image into
zones, the Zone Editor can be used to select which zones to recognize and in
which order. This option is best for documents with a simple page layout. (See
“The Zone Editor Window” on page 89. for more information on using the Zone
Editor.)
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Note: This option is not available with Automatic Recognition.

Column Selection

Choices made in Column Selection help OCR Shop distinguish between
different columns and/or column layouts within each of the designated zones. For
most OCR jobs, Auto Detect Mode can be effectively used by automatically
determining the text layout. If different zones contain different column layouts,
the user can have the Column Selection individually specify each zone in the
Zone Editor Window. (See “The Zone Editor Window” on page 89.). There are
four basic options for column selection:

Auto Detect Mode

This selection allows OCR Shop to determine the text layout within each zone by
itself.

Single Column/Table

This selection tells OCR Shop that there is one main column in your selected area
to recognize.

Multiple Columns

This selection tells OCR Shop that there is more than one main column in the
selected area to recognized.

No Parsing

This selection directs OCR Shop to disregard all formatting in your selected area
to recognize.

Retain Formatting

This selection box indicates to OCR Shop that you want to retain as much of the
original format as possible.
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Document Selection

OCR Shop allows the user to name and customize the document be scanned for
recognition. Text files are automatically named in numerical order using the
entries in the Document fields. 

Output filenames have the following format: 

document_namedXXXpYYY.file_suffix

where “XXX” indicates the document number, and “YYY” indicates the page
number. The page number is only used if Multiple Pages -> Single Document is
selected.

An example might be one in which the Document Name is set to “green”, the Doc
# is “5”, the Page # is “3”, the file suffix is “txt” for a standard text format, and
Multiple Pages -> Single Document is selected, In this cas, the next text output
might be written to the filename “greend005p003.txt”. If Multiple Pages ->
Single Document is not selected, then the filename would be “greend005.txt”.

Document Name

Enter the base filename to be used in building output text and image filenames.

Doc #

Enter the current document number to be used in naming output files.

Page #

Enter the current page number to be used in naming output files.

Multiple Pages -> Single Document

This selection indicates that filenames should include the page number. Note that
when page numbers are used, the document number remains constant while
scanning multiple pages will cause the page number for each new text output file
to increase by one, The document number will only be incremented in this way
if the user has chosen Blank Page is Document Separator in the
Document Specification window and a new document is indicated. (See “The
Document Specification Window” on page 83.).
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Document Specification...

Clicking Document Specification... calls up the Document Specification
window. See “The Document Specification Window” on page 83. for more
details.

Start Recognition button

OCR Shop begins the recognition process once all the settings have been chosen
and Start Recognition has been clicked.

Dismiss button

The current settings and recognition process can be canceled by clicking on
Dismiss and both the Main Menu and the Toolbar will reappear.
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Overview

The Scanner Set-up window appears when you click the Scanner Set-up button
in the Recognition settings window or the Batch Scan window.

The Scanner Set-up window contains a set of standard scanner features and a
number of features specific to your particular scanner. OCR Shop automatically
determines which features are available for your scanner and displays the
appropriate control elements. Extended image processing features specific to
your scanner are available through the Options... button.

In this chapter, the standard scanner features are described. For specific
information about the supported scanners and screnn shots of their Scanner
Set-up windows and  options windows, please see Appendix  A, “Scanner and
Printer Specific Features”,.
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The Scanner Set-up Window

The Scanner Set-up window is divided into two sections. The left half is the scan
preview area. It contains an area surrounded by a solid line, which represents the
scannable area. Inside this area is a resizable selection box containing the portion
of the image to be scanned. By click-dragging the corners of the selection box,
you can change the size of the region to be scanned. By click-dragging the center
of the box, you can move it to another location on the page.

The right half contains the scanner controls. The standard menus and buttons that
appear on the right side are described in this section.

Figure 8-1  Scanner Set-up
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Scanner

Click on the Scanner menu button to see all the available scanners. If you have
no supported scanners connected, the first item in the box will say “No Scanners
Available”. The last item will always be “show all devices”. 

The “show all devices” option pops up a dialog which gives you a list of all the
SCSI host IDs, the SCSI devices connected to them, and their status. This is a
useful feature for determining which SCSI IDs are available, as well as which
devices are currently connected. Also, if you have a National Instruments GPIB
driver and interface installed, GPIB devices will appear at the end of the list. You
can use the scroll bar on the side of the window to view all of the items listed.

Figure 8-2  Selecting the Scanner

Figure 8-3  Device List
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Dots per Inch

The resolution of the scan is user-definable to the extent that the selected scanner
allows. The choices are listed in this button menu. When you choose “other”, a
pop-up dialog will enable you to set other values and/or separate x and y
resolutions (not supported by all scanners).

Bits per Pixel

A bit is the basic atom of information in the computer. The bit resolution is the
number of bits used to represent each pixel.

Different selections will be displayed depending on which scanner you have
selected.

Figure 8-4  Selecting Dots Per Inch

Figure 8-5  Selecting Bits Per Pixel
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The following table lists the bits per pixel and pixels per byte required for 
different types of images:

Remember that the more information stored per pixel and the greater your dpi,
the larger your file size will be. An 8.5 x 11 inch image at 120 dpi and 1-bit
resolution will have a file size of 164K, at 4-bits 655K, at 8-bits 1.3 MB, and at
24 bits 4.0 MB.  (The file sizes for 6 and 8 bits/pixel images are the same because
6 bit pixels are stored in 8 bit bytes.)

Brightness

The brightness is set with a slider bar, with a higher degree of brightness at the
right end of the scale, and a lower degree of brightness at the left end of the scale.

Threshold

The threshold control, available on certain scanners for 1 bit/pixel scans,
determines the balance of black and white pixels in the scanned image. You can
specify a certain intensity as the threshold, and the scanner will convert all the
pixels that are lighter than the threshold to white and all pixels that are darker

Table 1: 

Image Type Bits/Pixel

Line Art/B & W Images 1

Grayscale (16 grays) 4

Grayscale (64 grays) 6

Grayscale (256 grays) 8

Color (16.7 million colors) 24

Figure 8-6  Selecting Brightness
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than the threshold to black. The effects of thresholding are most noticeable when
an image with many medium gray shades is scanned.

The Threshold option works in 1 bit/pixel mode only. In gray-scale and color
modes, the Threshold option is disabled (i.e. grayed out).

Automatic Document Feeder (ADF)

The Automatic Document Feeder (ADF) (not shown in the scan window example
above) feeds documents for scanning in portrait (vertical) or landscape
(horizontal) orientation. Automatic Document Feeders are standard for some
scanners, and either optional or not available for others.

Document Size

You can specify the area to be scanned from a predefined list of typical paper
sizes, or define your own area by using the mouse, or by entering the dimensions
numerically through the keyboard. OCR Shop dynamically loads information
about standard document sizes supported by your scanner (for example, letter,
legal, A4, etc.). The Document Size menu button will display them and you may

Figure 8-7  Selecting Threshold

Figure 8-8  Selecting ADF Usage
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select any of the presets available in the list. Common document sizes are listed
here.

To select an area to scan within the preview area, drag the rubber-band selection
box around the area you wish to scan. Alternatively, enter the x and y origins as
well as the desired scan width and height in the editable text fields provided for
these values. All dimensions can be entered and displayed in inches, millimeters
or pixels (pels).

Important Note: To enter origins and dimensions from the numeric keypad 
on the keyboard, you must enable Number Lock on the keypad.

Image Size

The image size is displayed in bytes at the bottom right-hand corner of the scan
setup window. It changes dynamically as you change the scan area or modify the
dpi or bits-per-pixel resolution.

Preview

This button will initiate a preview scan. To produce the preview image, the
scanner makes a fast scan of the full scanning area at the lowest possible dpi and

Table 2: 

Document 
Name

Inches Millimeters

letter 8.5x11 216x297

legal 8.5x14 216x356

A3 11.7x16.5 297x420

A4 8.27x11.7 210x297

A5 5.82x8.27 148x210

B4 9.8x13.9 250x353

B5 6.9x9.8 176x250
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displays it in the preview area. This is a useful, time-saving feature for the
following operations:

Checking Scanning Options

When you modify the scanning options for your image, you can use Scan
Preview to check the results prior to invoking a full-resolution scan. Scan
Preview supports all the scanner options except the Automatic Document Feeder
(ADF), which must be disabled, and horizontal mirroring.

Checking the Scanning Area

If you only need to scan a portion of the image, select that portion by holding
down the selection button and drawing a box around it in the preview area. A
preview scan can be used to verify the enclosed area.

Options

Options pops up a dialog which gives you access to the extended imaging
features of your scanner. To activate an option, click on the applicable button box.
For more details, please see “Appendix A: Scanner and Printer Specific Features”
on page 109 for more information about your scanner’s particular features.
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Overview

Clicking on Document Specification... in the Recognition settings window opens
the Document Specification window in which the user has the opportunity to
specify text and image variables as well as file saving options. The Document
Specification window contains the following components:

• Grouping

• File Save Options

• Text Directory, Format, and Suffix

• Image Directory, Format, and Suffix
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The Document Specification Window

Grouping

Scanning with an ADF or Automatic Document Feeder is most effective when
utilizing Grouping Options of which there are two possible selections:

Double-sided Documents

Select Double-sided Document(s), if your documents are double-sided. OCR
Shop will process the entire batch of pages in the ADF and then prompt you to
turn the batch over in the ADF so that the reverse sides can be processed. OCR
Shop will track the number of pages, such that, in the final document, all pages
will be in the correct order. This option is only available if Use Page Numbers is
selected.

For example, images to be scanned may consist of double-sided documents in
which the first page is numbered 1 on the front side and 2 on the back, while the
second page is numbered 3 on the front and 4 on the back, and so on to the end.

Figure 9-1  Document Specification
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then On the first pass, OCR SHOP will scan pages 1, 3, 5, and 7, and then on the
second will scan pages 8, 6, 4, and 2. The end result will be a single document
with all pages in the correct order.

Blank Page is Document Separator

When Blank Page is Document Separator is selected, OCR Shop will increment
the document number by one whenever it encounters a blank sheet of paper in the
ADF. and then reset the page number to page one. In this way, a whole stack of
different, multi-page documents could be scanned in one batch. By simply
slipping a blank piece of paper in between each document, OCR Shop will
repaginate them as if they were done separately. This option is only available if
Use Page Numbers is selected.

File Save Options

OCR Shop allows the user to customize the Save settings with the following
options:

• Overwrite Protection

• Auto Save Text without Editing

• Auto Generate Output File Suffixes

• Auto Save Graphic Blocks

• Save Image(s) of Whole Document

Overwrite Protection

OCR Shop automatically assigns filenames to recognition documents and image
files based on the Document name:, Doc #: and Page #: fields. Select Overwrite
Protection if you want OCR Shop to notify you whenever it is about to write to a
filename which already exists.

Auto Save Text without Editing

After a scanned image or image file has been recognized, OCR Shop saves the
file and displays the recognized text in a text editor window. If this is not desired,
select Auto Save Text without Editing.
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Auto Generate Output File Suffixes

Select Auto Generate Output File Suffixes if you want OCR Shop to
automatically generate an appropriate file suffix whenever you change the Text
or Image Format.

Auto Save Graphic Blocks

Select Auto Save Graphic Blocks if you want OCR Shop to save the graphics
from graphic zones in the recognized document. You must also select Specific
Zones or Automatic Zones and specify zone contents as Graphics in order for the
graphics to be retained.

Save Image(s) of Whole Document

OCR Shop normally does not save the scanned images of your documents but
only the recognized text in the Text Editor. Select Save Image(s) of Whole
Document to have OCR Shop automatically save image files as well as the text
files otherwise the images scanned will be lost.

Text Directory, Format, and Suffix

OCR Shop can be set for specifying text output file settings with the following:

Text Directory

Click Text Directory: to display the Select Text Directory window. Select the
directory you would like to use for your files, and then click OK. Your selection
will appear in the Text Directory: text field.

Text Format 

Your selection from the Text Format pull-down list indicates how you want your
recognized files to be created and saved.

Text Suffix

Your Text Suffix selection determines the default suffix that will be added onto
your recognized text filenames. This will be set automatically if Auto Generate
Output File Suffixes is selected.
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Image Directory, Format, and Suffix

Since by default, OCR Shop, does not save your documents’ scanned images, this
area can only be accessed if you select Save Image(s) of Whole Document from
the File Save Options: list thereby enabling image file settings to be saved.

Image Directory

Click Image Directory: to display the Image Directory window. Select the
directory you would like to use for your images, and then click OK. Your
selection will appear in the Image Directory: text field.

Image Format

Your selection from the Image Format pull-down list indicates how you want
your image files created and saved.

Select Multi-Page TIFF file if you would like all the image files from each
document to be saved into a separate, multi-image TIFF file.

Image Suffix

Your Image Suffix selection determines the default suffix that will be added onto
your image filenames. This will be set automatically if Auto Generate Output
File Suffixes is selected.
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Overview

The Zone Editor can be called up from either Interactive or Automatic
Recognition processing modes. It appears during Interactive Recognition, after
each image is scanned or read in, and before recognition begins. While in
Automatic Recognition, the Zone Editor is called up as part of the Automatic
Recognition set-up, so that once recognition has commenced, the same set of
zones is used for all images.

OCR Shop does this using the following concepts:

• Zone Editor usage and the Zone Editor window components

• File Menu

• Edit Menu

• Rotate Menu

• Zoom Menu

• Number, Delete, and Draw Selections

• Column Selection

• Zone Contents

• Continue, Clear Zones, and Cancel Buttons
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The Zone Editor Window

Figure 10-1  Zone Editor
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Zone Editor Usage

OCR Shop provides the Zone Editor for the following purposes:

Selecting only a portion of a page for recognition

Zones can be drawn around the sections of text intended to be recognized and 
the sections to be omitted are ignored.

Determining the order in which text it to be recognized.

You can specify the order in which the zones will be recognized, editing the 
order to make recognition easier and more accurate.

Specifying the contents of each zone 

You can specify whether particular zones contain letters, numbers, symbols 
and/or custom character sets for increased recognition speed and accuracy.

Creating zone files for standardized page processing

After you have drawn, ordered and specified the zones for a certain 
document, you can save the parameters as a zone template for use with 
similar, standardized pages.

File Menu

The Zone Editor File Menu allows you to load and save zone files, so you don’t
have to reset zones each time you recognize a new document. The menu
commands include:

• Load Zone File

• Save Zone File As

• Load Background Image

Load Zone File...

Choose Load Zone File... to load the zones from a previously saved zone file.
This is useful for quickly restoring the zoning variables specific to particular
documents.
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1. Choose Load Zone File... from the File Menu. The Load Zone Template
window will appear.

2. Select the zone file you want to use.

3. Click OK.

Save Zone File As...

Choose Save Zone File As... to save the currently loaded zone file under a new
file name.

1. Load the zone file you want to save under a different name, if you have not
already.

2. Choose Save Zone File As... from the File Menu. The Save Zone Template
window will appear.

3. Enter the new file information in the appropriate fields. 

4. Click OK.

Load Background Image...

Choose Load Background Image... to load a new image into the Zone Editor
window. which will be used only as a reference for drawing and editing zones.

1. Choose Load Background Image... from the File Menu. The Open Image
File window will appear.

2. Select the image you want to use.

3. Click OK. The new image will appear in the Zone Editor window.

Edit Menu

The Edit Menu allows you to undo changes you have made in the Zone Editor.

Undo

Choosing Undo erases the last change you made.

Undo All

Choosing Undo All erases all changes you made while in the Zone Editor since
it was called up.
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Rotate Menu

The Rotate Menu allows you to manipulate the position of the image loaded in
the Zone Editor window. Menu options include:

No Rotation

This default selection leaves the image as is.

90 Clockwise

This selection rotates the image 90º in a clockwise direction.

90 Counter-clockwise

This selection rotates the image 90º in a counter-clockwise direction.

180 Rotation

This selection rotates the image, so it is upside-down.

Zoom Menu

The Zoom Menu allows you to manipulate the view of the image loaded in the
Zone Editor window. Menu options include:

Fit to Window

This default selection lets you view whole pages of a document.

1:1

This selection displays every pixel of the image as a pixel on the screen.

Zoom In

This selection zooms in on whatever image view is on the screen at the time.

Zoom Out

This selection zooms out of whatever image view is on the screen at the time.
OCR Shop User’s Guide - 93



Chapter 10:The Zone Editor Window
Number, Delete, and Draw Selections

These three buttons allow you to add and delete zones as well as specify the zone
content, format and recognition order.

Number

Numbering the zones designates in which order OCR Shop will recognize the
text.

1. Select Number from the Zone Editor window. Note that the zones turn red
and the Number: fields are emptied.

2. Click on the zone you would like to be recognized first. Note that the zone
turns back to green and contains the number 1.

3. Click on the zone you would like to be recognized second. Note that the
second zone turns back to green and contains the number 2.

4. Repeat until all the zones you wish to be recognized are numbered.

Note: You can renumber zones you draw yourself as well as Automatic 
Zones OCR Shop has drawn for you.

Second note: Selecting Delete or Draw will take you out of Numbering 
mode. Any zones which have not been numbered when you leave Numbering 
mode will be deleted.

Delete

Deleting zones erases zone boundaries from the image.

1. Select Delete from the Zone Editor window. 

2. Click on the zone you want to delete. Note that the zone disappears.

3. Click on the next zone you want to delete. Note that the second zone disap-
pears.

4. Repeat until all the zones you wish to be deleted have been erased. 

Note: Any other zone you click on will be deleted until you leave Delete 
mode by choosing Number or Draw.
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Draw

Select Draw to draw your own zones.

1. Select Draw from the Zone Editor window. 

2. Click and hold the mouse button down where you want the new zone’s cor-
ner to be. Stretch the box until it contains the desired area of text or graph-
ics.

3. Release the mouse button. The new zone will be in position.

4. Repeat until you have drawn your desired zones.

Column Selection

The Column Selection options are the same as in the Recognition settings
window although in the Zone Editor, you can specify different selections for each
zone. (See “Column Selection” on page 72.).

1. Select the zone, for which you want to specify the Column Selection, by
clicking on it.

2. Select the desired layout from the Column Selection: pull-down menu. 

3. The zone will contain the new layout under the Contents: field.

Zone Contents

The zones’ Contents: field helps OCR Shop determine whether it should be
looking for letters, numbers, graphics, and/or symbols during recognition.

There are five possible zone content descriptions:

1. Alpha-Numeric--This indicates that the zone contains letters and/or num-
bers.

2. Alpha--This indicates that the zone contains only letters.

3. Numeric--This indicates that the zone contains only numbers.

4. Graphic--This indicates that the zone contains only graphics.

5. Custom--This indicates that the zone contains a special set of characters as
specified in a zone contents file.
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Specifying the Contents of a Zone

1. Select the zone, for which you want to specify the contents, by clicking on
it.

2. Select the appropriate content description from the Zone Contents
pull-down menu. 

3. The zone will contain the new content description in the Contents: field.

Using Custom Zone Contents Files

A file saved with the Zone Contents File Editor lets the user determine specific
characters for OCR Shop to look for during recognition. This is particularly
useful for increasing recognition speed and accuracy when you know certain
zones will contain unique characters or symbols.

For example, if you were to collect a survey, in which each of the responses was
one of the letters a, b, c, d, or e, you could create a contents file containing only
those letters. OCR Shop would then know that each recognized character would
have to be one of the five letters and could quickly distinguish between them.

You can also create contents files for unusual symbols, such as copyright or
trademark symbols.

Such custom zone contents files are created using the features of the Zone
Contents File Editor. See Figure 10-2.
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Creating a New Custom Zone Contents File

1. Choose Custom... from the Zone Contents pull-down menu. The Zone Con-
tents File Editor will appear.

2. Select characters from the Extended ASCII scrolling menu, and/or enter the
characters you would like to add in the Zone Content(s): field.

3. You will need to save the zone contents file before you can assign its con-
tents to the a particular zone. Click Save... and enter the desired filename.

4. Click OK. The file will be saved with the suffix: .zcn.

5. Click Apply to accept the new zone contents file and assign it to the selected
zone, if any.

Editing a Custom Zone Contents File

To assign a zone contents file to a particular zone or zones, make sure that the
appropriate zones have been selected. Call up the Zone Contents File Editor by
choosing Custom... from the Zone Contents pull-down menu.

1. Click Load... to load an existing zone contents file.

2. Click Save... to save the current zone contents file.

Figure 10-2  Zone Contents File Editor
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3. Click Revert to reset the editor to the last saved file.

4. Click Clear to clear the Zone Content(s): field.

5. Click Apply to quit the editor and assign the current zone contents field to
the currently selected zone(s). The zone contents filename will appear in the
selected zone(s).

6. Click Cancel to quit the editor without making any zone contents file
assignments.

Continue, Clear Zones, and Cancel Buttons

Use these buttons to control the Zone Editor window as a whole.

Continue

Clicking on Continue will close the Zone Editor once all necessary editing of the
zones is completed, and either recognition will begin (Interactive Recognition)
or the user will be returned to the Recognition settings window (Automatic
Recognition).

Clear Zones

Clicking Clear Zones will erase all zones from the Zone Editor window.

Cancel

If you wish to abort zoning altogether, click Cancel. Clicking Cancel in the
middle of a recognition process, will also bring up a window asking if you would
like to abort recognition altogether.
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Overview

The OCR Shop Train Characters window has the following functions:

• Specify...

• Save...

• Append...

• Cancel
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The Train Characters Window

The Train Characters window contains the set of all symbols collected by the
OCR driver, during recognition along with their ASCII translations. If OCR Shop
is unable to match a particular symbol to its known set of characters which
include foreign language characters specified in the Languages Menu, then the
reject character set as the default will appear beneath the symbol. See
Figure 11-1.

Specify...

A particular character assignment made to a symbol, can be modified by
double-clicking on the symbol below, Alternatively, the user may first select the
symbol by clicking on it, and then click Specify... to call up the Specify Character
window. See Figure 11-2.

Figure 11-1  Train Characters
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Note: You can only specify one character at a time.

The Specify Character Window

1. Select the correct character by locating it in the Extended ASCII scrolling
menu and double-clicking on it Another way would be to enter it directly
into the Character(s): text field by clicking on the text field and typing in the
correct character(s).

2. Click OK to accept the new character(s).

Delete

Use Delete to remove a particular symbol from the trained character set.

1. Click on the unwanted symbol to select it.

2. Click Delete to remove it.

Figure 11-2  Specify Character
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Append...

Use Append... to merge the current trained character set with another,
pre-existing trained character set.

1. Click Append... to call up the Append Training Glyphs To... window.

2. Verify that the directory is correct, and select the filename of the existing
trained character set.

3. Click OK.

Save...

Use Save... to save the current trained character set to a new file.

1. Click Save... to call up the Save Training Glyphs To... window.

2. Entire the desired filename.

3. Click OK. The trained character file suffix .trn will automatically be added.

Cancel

Click Cancel to discard the current trained character set and exit the Train
Characters Window.
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Overview

OCR Shop utilizes Caere OCR technology to accomplish its fast and accurate
optical character recognition.
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General description

OCR stands for optical character recognition: the process of transferring text
from printed pages into a computer file on screen that can be edited— without
retyping.

A scanner is more than a copy machine that simply transfers an image into your
computer. Rather, it translates a page into data by dividing up the image into
millions of dots or bits (usually from 40,000 to 90,000 per square inch) and then
assigns a value to each dot, depending upon whether it is inked, partially inked,
or blank.

The composite document stored in your computer is the map of these dots, that
is, a bitmap. Your computer sees this data not as editable text, but as one
bitmapped image.

OCR then, is the process of translating this bitmap into editable text. Text
characters are designed by assigning a code corresponding to each key on the
keyboard, be it a letter, number or symbol. There are a variety of different code
sets in use, but the most common code set is the ASCII (American Standard Code
for Information Interchange) table of character equivalents. ASCII is generally
recognized as the universal code for most computers. Almost every program that
uses text and/or numbers understands ASCII.

Prior to 1988, matrix-matching, the process by which a bitmap’s shape is
compared to a library of character shapes, was the only method of text
recognition. Because matrix-matching required exact matches, it only worked for
a small number of fonts and sizes. Thus, it was neither widely used nor
recognized as a useful process. This changed when Caere released OmniPage, a
page-recognition program that incorporated OCR technology based on
feature-analysis. Now, the process involved individual character features being
analyzed for recognition rather than matrix-matching for shapes as earlier OCR
had done.

OCR Shop utilizes Caere’s proprietary OCR technology, OmniPage.
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Basic OmniPage OCR Technologies

When converting the bitmapped image into usable text, OCR software must do
the following:

• Analyze the structure of the text to detect the presence of columns or
headlines.

• Separate text from graphics.

• Isolate each character in the text in order to correctly identify it.

• Interpret the recognition results and resolve any ambiguities.

• Format the results by examining and reproducing the font and page layout
information.

AnyFont

AnyFont technology is the first true page-recognition approach to OCR. Rather
than work from the matrix-matching approach, OmniPage takes an expert system
approach with entire pages, recognizing most typed, proportional, and typeset
fonts automatically. This is accomplished by using recognition algorithms, small
program-like procedures that make the process possible.

Page Analysis

An 8 1/2” by 11” document at 300 dots per square inch will create a 1.2 MB file.
AnyFont first puts that entire file into RAM and looks at the complete page. From
there, the recognition algorithms search for and identify areas which may contain
graphics by using image-processing techniques, such as texture and density
analysis and edge detection.

Next, the recognition algorithm looks for columns of text as well as white lines
between text, immediately determining their size and shape. Finally, spaces
between the letters are identified, and OmniPage determines that a character with
a specific point size lies within this variable-sized zone. This technique of
zooming in from a full-page view allows OmniPage to recognize one of the
widest variety of font sizes in the industry.

Character Experts

Each character zone is sent to a team of 100 expert systems whose individual
subsystems are responsible for the identification of a single character. This is a
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marked contrast to other OCR technologies that are based upon probability
analysis of dots within a matrix field.

The first of AnyFont’s 100 experts evaluates the image and decides if it is the
character for which the expert is responsible within the process. If it is not
certain, it passes the character on to the next expert. This continues until each
character is recognized by its appropriate expert. No probabilities or guesses are
used. This individual expert technology is theoretically the most accurate method
possible for recognizing characters. 

Each expert for each character can be infinitely tuned and re-tuned as new fonts
or new problems arise. If there is a problem with a “c” and an “e,” for example,
additional tuning of the two appropriate experts continues until the two
characters are distinguished from one other. To distinguish a foreign language’s
characters, such as an “a” and an “å,” an additional expert is added to identify the
new character. This approach to recognition is what allows OmniPage to
recognize more languages, with remarkably fewer substitution errors, than any
other OCR package.

Self-Learning OCR

One patent pending of Caere’s expert systems has to do with an accelerating,
self-learning routine which only requires each unique character to be recognized
as “new” once. From then on, the system is able to identify new characters as
easily as the others without having to reanalyze it each time. This accelerator
technique makes OmniPage actually speed up as it reads a document. This
technology, operating in true 32-bit mode, makes AnyFont the fastest omnifont
OCR algorithm in the world.

In some cases, none of the experts are able to identify a character because of
broken or overlapping characters in the image. AnyFont remedies this in its
second pass. The characters, or pieces of characters, which AnyFont cannot
identify, are put in a separate buffer to be dealt with later. A series of exacting
routines are then activated for splitting, combining, fattening, thinning,
analyzing, and context checking of the fragments. The quality and exactness of
this second pass provide greater recognition accuracy, even for problem and
incomplete characters. In addition, a third pass allows the Language Analyst to
further refine accuracy.
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AnyPage Technology

AnyPage is Caere’s proprietary dynamic auto-thresholding technology. In many
ways it is similar to the HP AccuPage 2™ technology available for
Hewlett-Packard scanners. AnyPage’s main function is to identify and
distinguish the varying scales of gray images. Utilizing the relationships between
the numerous gradients, AnyPage determines what areas of a page are actual text
and what areas are only background, all on a dynamic, real-time basis.

AnyPage repeats this process of automatically designating “text” and
“background” areas not just once for the entire page, or in large blocks at a time,
but over thousands of regions per page. The “backgrounds” are dropped out,
leaving a very clean and sharp “text” image, which is then transformed into a
bi-modal black and white image to be delivered to the AnyFont OCR engine. 

This technology allows OmniPage to recognize areas in documents that other
OCR packages cannot even see, such as black print on grey stationery, sidebars
in the Wall Street Journal, or even stained and yellowed documents. 

Compound Neural System

Just as our brain can still recognize letters when some characters are fragmented,
Caere has developed a computerized compound neural system that has “learned”
to recognize damaged characters in documents.

OmniPage’s neural system consists of several neural networks, which are made
up of rows and columns containing software-stimulated neurons. Each neuron
weighs evidence provided by the image as well as information provided by other
neurons within the network to compute the probability of specific possible
characters.

AnyFax

The AnyFax portion of the neural system is specially designed to work with low
resolution fax images. It uses an image enhancement process that disconnects
joined characters and reduces the jagged character edges created during the
faxing process.

Fax transmissions also commonly suffer from static or “noise” during
transmission, creating missing or split lines. Since fax signals are represented by
a series of CCITT codes, AnyFax technology was developed to determine the
missing CCITT codes and reconstruct them.
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The Language Analyst

The Language Analyst uses contextual and word usage rules to evaluate
characters during the recognition process. It examines each page, referring to
dictionaries with over 100,000 words in up to eleven languages, and makes
corrections as needed.

Trigram Analysis

Trigram analysis looks at letter sequences in sets of three and determines the
likelihood that those three letters would appear together in the language that is
designated for text recognition. For example, in English text, OmniPage will
generally expect the letter “u” to follow the letter “q” and knows that “qui” is a
more likely letter combination than “qul”.

3D OCR

3D OCR is a revolutionary new technology that is available to OmniPage users.
It is designed to provide precision accuracy for the most problematic documents,
such as multi-generational photocopies and pages with very small type. 3D OCR
does this by recognizing grey areas of images as well as bi-level, black-and-white
parts.

Examination of a character’s grey data, in addition to its black character image,
provides a complete picture of the character’s shades, shapes and contours, and
thereby maximizes recognition accuracy. For example, imagine typing on a
typewriter with ribbon that is running out of ink. Some of the letters will be
illegible; the letter “n” might look like the letter “r.” The missing section might
appear very lightly inked. 3D OCR would evaluate the grayscale information
from the lightly inked area and correctly recognize the letter as an “n.”

Or, imagine applying too much ink to a rubber stamp. When you press the stamp
onto a piece of paper, the words may be completely blurred. 3D OCR would
evaluate the grayscale information and decide that when compared to the
darkness of most of the character, the extra blurred areas are probably a smudge.
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Scanner and Printer Specific Features
Bell & Howell Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• Copiscan 4000 series

• Copiscan 3338A, 6338, etc. (all models) with RSC-11 or 21

• Copiscan 8000 series

• (500 FB - see Ricoh Aficio IS-01)

• (1000 FB - see Ricoh IS-420)

• (1500 FB - see Ricoh IS-430)

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
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To operate OCR Shop with your Bell & Howell scanner, a remote SCSI
controller is required.

Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 200, 240, 300, and “other...”.

Figure 0-1  Bell & Howell Scanner
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Bits Per Pixel

Bell & Howell scanners scan at 1 bit/pixel for black and white. Current
scanner/controller models do not support gray scale or color scanning.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Threshold

The threshold slider bar allows you to select the level, below which all pixels are
set to black, and above which all pixels are set to white. Moving the slider bar
setting to the right increases this threshold level.

Auto Document Feeder

If you try to scan with the ADF selected but have no paper inserted in the ADF,
an error message will appear at the bottom of your image display window. The
Preview function is disabled when the scanner is in ADF mode.

Certain pre-defined document sizes are supported by the ADF when it is
installed:

• letter (port and land)

• legal (port)

• 11” x 17”

• A5 (port and land)

• A4 (port and land)

• A3 (port)

• B5 (port and land)

• B4 (port)

“port” is short for portrait mode, which orients the paper with the narrower side
on top. Portrait is the default setting.

“land” is short for landscape mode, which orients the paper with the wider side
on top.
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Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• letter

• letter (land)

• legal

• 11” x 17”

• B5

• B5 (land)

• B4

• A5

• A5 (land)

• A4

• A4 (land)

• A3

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Horizontal Mirror

This option allows you to do a scan which mirrors the image over a vertical axis
down the center of the image, thus reversing the image left-to-right. Note that in
portrait mode, this axis cuts through the narrower sides, while in landscape mode,
it cuts through the wider sides.

Dithering

Selecting Dithering can help make a black-and-white scan represent gray images.
It does this by varying the size of clusters of black pixels. When viewed at arm’s
length, the dots blur, and the resulting image appears to have gray tones.

Figure 0-2  Bell & Howell Settings
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Compression

When built-in compression hardware is present, this control allows you to select
the type of compression that will be recorded in the image’s Settings file, for use
when scanning directly to a file. Note that images scanned to a displayed window
will not be compressed.

ACE Sensitivity & ACE Function

These controls allow selection of Advanced Contrast Enhancement functions to
improve image contrast. Available choices are: lighten, photo, line art, mixed,
and darken.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Canon Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• CJ-10 with IPU-SS (scan and print)

• CLC-10 with IPU-SS (scan and print)

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
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Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 50, 72, 75, 80, 90, 100, 120,
144, 150, 160, 180, 200, 240, 300, 320, 360, 400, and “other...”. (One bit/pixel
has only 400 dpi available.)

Figure 0-3  Canon Scanners
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Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white,
8bits/pixel for gray scale, and 24 bits/pixel for color.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Threshold

The threshold slider bar allows you to select the level, below which all pixels are
set to black, and above which all pixels are set to white. Moving the slider bar
setting to the right increases this threshold level.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• letter

• A5

• A5 (land)

• A4

• B5

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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Note: No SCANNER SETUP OPTIONS are available with the CJ-10.

CJ-10 PRINT CONTROLS

The OCR Shop Print Controls window provides controls for the position,
orientation, geometry, and general treatment of the image from OCR Shop’s
main window. OCR Shop must have an image loaded before you will be able to
bring up the Print Controls window.

Printer Selection

The Printer menu shows the printers that are available. If you don’t have any
printers available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Figure 0-4  Canon Print Controls
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Copies

The Copies control allows you to specify the number of copies that will be
printed when you click on the Print button.

Orientation

The Orientation control allows you to specify whether your image will be printed
with portrait (default) or landscape orientation. The icons used to represent these
two orientations are the house standing up (portrait) and the house turned 90
degrees counter-clockwise (landscape).

Image Size

The Image Size control is one of the most powerful controls in the OCR Shop
printing software.

• Original Image Coordinates

Select this to scale your image according to the information about its size
from when it was read from an image file or scanned. Not all image files save
DPI (dots per inch) dimensional information. In such cases, a default of 72
DPI is assumed (unless overridden by the “pdpi=n” command line
parameter).

• Printer’s Native Resolution

Select this option if you want to guarantee that every pixel in the original
source image will be printed as one pixel in the output. This action will occur
regardless of any differences in the source image’s and printer’s DPI, so the
size of the printed image may not be the same as that of the scanned original.

• Scale To Fit

This is useful when you want the image to fit exactly within the full printable
area of the selected printer. One result of this process is that images with
different sizes will be printed with different magnification or reduction ratios
to make them fit.

• Manual

This will be the selection indicated if you manually drag the resize handles
of the image icon on the left side of the Print Controls window, or if you enter
values in the numeric fields. The units for entered values can be selected as
Inches or Millimeters.
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Lock X & Y Scale

This check box control (on by default) will keep your manual scaling applied
equally to the height and width of your image when it is selected. If you uncheck
it, then your manual scalings will not necessarily be symmetric. In other words,
your printed image may look squashed or stretched.

Use Whole Page

This control (off by default) will allow you to position part or all of your image
upon the non-printing border area of the printer’s page. Normally, these areas are
protected, and no part of the image may be placed within them.

However, sometimes you may want to print a full page image that was scanned
at the same DPI as the printer (for example, with Printer’s Native Resolution
selected for Image Size). Turning on the Use Whole Page option allows you to
position the image over the non-printing border area. Note that clipping will
occur.

Almost all printers have some non-printable border area, and OCR Shop takes
this area into account for each printer supported.

X0, Y0, Width, Height

The print size may also be set manually, either by dragging a rectangle in the print
preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches or Millimeters.

Center X and Center Y

These controls will position the image so that it is centered on the page, either
horizontally or vertically, when it is printed. Their effect is just like clicking on
the center of the image selection box and dragging it until it has been centered in
the appropriate direction.
120 - OCR Shop User’s Guide



Appendix A:Scanner and Printer Specific Features
PRINT CONTROLS OPTIONS

This window provides access to printer-specific settings.

Sensitometry Table

This menu lets you select a “treatment” of your image as it goes to the output
medium such as CIO Paper, etc. Your printer’s configuration may be

Figure 0-5  Canon Print Options
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automatically sensed, so that the treatment choices available in this menu will
depend on the printer selected and its output media.

Paper Size

Different paper sizes or sources may be selected through this menu. The
following standard sizes are typically offered:

• letter (paper)

• letter (transparency)

• A4 (paper)

• A4 (transparency)

Gamma

The Gamma control activates image altering functions within the printer that are
provided to compensate for characteristics of certain image sources. The
following source selections are available: scanner, video, and
computer-generated graphic.

Black Text Mode

Enabling this control enhances the printing of text and line art when it is being
printed simultaneously with color images. Characters and lines will appear closer
to black.

Brightness or Color Balance Lock (RGB)

These are general brightness controls for affecting the saturation or tone of an
image. Experiment with these controls and with the Gamma and Sensitometry
controls to attain the best results.

Printer Reports

This is a small text display area that shows information about the printer you are
using. Information here will include ROM version information and other
information that particular printer models report about themselves.
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Epson Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• Action scanner II, ES-300C, ES-300GS, ES-600C, ES-800C, 
ES-1000C, ES-1200C, ES-8000

• GT-1000, GT-300, GT-4000, GT-5000, GT-5500, GT-6000, GT-6400, 
GT-6500, GT-8000, GT-8500, GT-9000, GT-9500, GT-12000

• Expression 636, Expression 836XL, Expression 800C

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
OCR Shop User’s Guide - 123



Appendix A:Scanner and Printer Specific Features
Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 50, 60, 72, 75, 80, 90, 100,
120, 133, 144, 150, 160, 175, 180, 200, 216, 240, 300, 320, 360, 400, 480, 600,
and 800.

Figure 0-6  Epson Scanners
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Bits Per Pixel

Four levels of bits per pixel are offered: 1 bit/pixel for black and white,
4bits/pixel for gray scale, 8bits/pixel for gray scale, and 24 bits/pixel for color.

Auto Document Feeder

If the ADF is installed, its checkbox will appear “solid.” When available, clicking
on this checkbox alternately enables and disables use of the ADF for scans.

If you try to scan with the ADF selected but have no paper inserted in the ADF,
an error message will appear at the bottom of your image display window. The
Preview function is also disabled when the scanner is in ADF mode.

Transparency Unit

Clicking on this checkbox, if it is available, selects scanning using the
transparency unit. This will allow you to scan from a transparency.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Zoom X, Zoom Y

Entering percentage values in these controls lets you change the magnification of
the scanned image, while preserving the DPI value. For example, choosing a
value of 200% along a particular direction will cause twice as many pixels to be
used to represent the same length, so that at a constant DPI, that image will be
twice as long in that direction.

The zoom can be set from 50% to 200% in 1% increments.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• letter

• A5

• A5 (land)
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• A4

• B5

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).

SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Figure 0-7  Epson Scanner Options
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Sharpness

Five levels of sharpness are available on Epson scanners. Select the desired
degree of sharpness by clicking on the corresponding control.

Halftoning Mode

When scanning in 1 bit/pixel-color and 2 bit/pixel-color data format, continuous
tone images cannot be properly expressed. Halftoning processes the data to
simulate continuous tones. Halftoning is a variation of dithering in which
patterns of dots are used to give the impression of gray. Most dithering methods
use a fixed pattern of dots. The Epson halftoning mode uses a proprietary method
which produces better results.

• Mode A: Distinct

This is the standard mode which creates a hard, distinct tone.

• Mode B: Soft

This mode converts the image into a softer tone. It is suited for images that
contain large areas of similar tones. 

• Mode C: Newspaper

This mode represents the image in a way similar to the screening method
commonly used for newspaper photographs. The gradations of tone are
represented by clusters of different numbers of dots.

Gamma Curve

Gamma Curve adjusts the light intensity scale between the original image and
output image so that when the image is reproduced on some devices, the tones in
the reproduced image may be closer to those of the original image.

• Display A: Linear

The output data is proportional to the original image. This setting is suitable
for most types of computer displays which can display images in the 1
bit/pixel-color format or up to 8 or 16 colors. This mode is also suitable for
images without continuous tones, such as line art.

• Display B: Non-Linear

This setting is suitable for analog-input CRT displays which can display
images with multiple levels of tones of more than 1 bit/pixel-color.
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• Printer A: High Density

This setting is suitable for high density printers, such as 24 dot matrix
printers and page printers. With this function applied, the image is converted
into a light image as it is scanned to compensate for the higher (darker)
density of such printers. The same image will look faint when viewed on a
CRT display.

• Printer B: Low Density

This setting is suitable for low density printers, such as 8 dot (9 pin) printers,
page printers, and ink jet printers. As it is scanned, the image is converted
into a slightly lighter image to compensate for the lower density of such
printers. This setting is lighter than Printer Output A. The image will look
slightly faint when viewed on a CRT display.

• Printer C: High Contrast

This setting is suitable for the high contrast printing of images that contain
both photos and text. This setting gives higher contrast and more definition
to the darker areas, like characters and lines, than either Printer Output A or
B, while parts with graphic images are given gamma correction for printing.
Both the darker and lighter parts of the images are accentuated by this
method.

Color Correction

Color Correction processes the color data of the image so that the data is better
suited to the characteristics of the color output device. With the color correction
function, reproduction of the colors of the image data comes closer to the colors
in the original images.

• CRT Displays

This setting adjusts colors for the characteristics of color CRT displays.

• Thermal transfer printers

This setting compensates for the characteristics of thermal transfer printers.

• Impact dot matrix printers

This setting compensates for the characteristics of color impact dot matrix
printers.

• Ink jet printers
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This setting compensates for the characteristics of ink jet printers.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Fujitsu Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• ScanPartner 10

• ScanPartner 10C

• ScanPartner M3096G+/m

• ScanPartner M3096Gx

• ScanPartner M3097G (Rev 2 firmware adss grayscale support)

• ScanPartner M3099G Duplex scanner

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
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For operation with OCR Shop, your Fujitsu scanner will need to have the
memory option installed.

Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are normally available: 200, 240, 300, and 400.
Additional selections are available if the optional Image Processing Circuit (IPC)

Figure 0-8  Fujitsu Scanners
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Board is installed. For more information, please see the “Image Processing
Circuit Board” section below.

Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white and
8bits/pixel for gray scale.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Contrast

The contrast slider bar allows you to vary the image contrast. Sliding the bar to
the right increases the contrast.

Threshold

The Fujitsu scanner supports two kinds of threshold controls: regular (or static)
threshold and dynamic threshold. Static threshold corresponds to the most
generally used kind of thresholding, where at an established level, all lighter
pixels become white and all darker pixels become black. The slider bar allows
you to select 64 threshold levels.

The Dynamic Thresholding feature is available only when the optional Image
Processing Circuit board is installed. If the board is not installed, the Dynamic
Thresholding checkbox is disabled. (Please see the “Image Processing Circuit
Board” section below.)

Dynamic Thresholding uses a variable threshold level. It is especially useful in
the scanning of signatures which consist of variable line weights. Dynamic
Thresholding automatically adjusts the threshold to extract lightly stroked
handwritten characters. It does this by analyzing the reflected light from the
page. If there is a small variation in the signal, indicating a faint line, the scanner
reduces the threshold setting to a point where it can distinguish between the faint
line and the background.
132 - OCR Shop User’s Guide



Appendix A:Scanner and Printer Specific Features
Auto Document Feeder

If you try to scan with the ADF selected but have no paper inserted in the ADF,
an error message will appear at the bottom of your image display window. The
Preview function is disabled when the scanner is in ADF mode.

Certain pre-defined document sizes are supported by the ADF when it is
installed:

• letter (port and land)

• legal (port)

• 11” x 17”

• A5 (port and land)

• A4 (port and land)

• A3 (port)

• B5 (port and land)

• B4 (port)

“port” is short for portrait mode, which orients the paper with the narrower side
on top. Portrait is the default setting.

“land” is short for landscape mode, which orients the paper with the wider side
on top.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• letter

• letter (land)

• legal

• 11” x 17”

• B5

• B5 (land)

• B4

• A5
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• A5 (land)

• A4

• A4 (land)

• A3

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Dithering

Dithering can help make a black-and-white scan represent gray images. It does
this by varying the size of clusters of black pixels. When viewed at arm’s length,
the dots blur, and the resulting image appears to have gray tones.

The list of available dither patterns depends on the particular scanner selected.
For this scanner, the following are available:

• None

• Photographs 1

• Photographs 2

• Characters/Photos 1

Figure 0-9  Fujitsu Scanner Options
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• Characters/Photos 2

Gamma

Through the Gamma control, you can adjust the light intensity scale between the
original image and output image so that when the image is reproduced on some
devices, the tones in the reproduced image may be closer to those in the original
image.

Compression

When built-in compression hardware is present, this control allows you to select
the type of compression that will be recorded in the image’s Settings file, for use
when scanning directly to a file. Note that images scanned to a displayed window
will not be compressed.

Image Processing Circuit Board

The optional Image Processing Circuit Board offers a number of image
processing features for the Fujitsu M3096G/H and M3097G scanners. The board
is shipped separately from the scanner and should be installed by a
Fujitsu-authorized and trained service technician.

The IPC board offers the following image enhancement options:

• Photo Invert

• Horizontal Mirror

• Automatic Discrimination

• Outline Extraction

• Edge Emphasis

• Dynamic Thresholding (see “Threshold” above)

If the board is not installed, these options will be disabled.

Photo Invert

Selecting this control will let you scan the “negative” of your images.
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Horizontal Mirror

This option allows you to do a scan which mirrors the image over a vertical axis
down the center of the image, thus reversing the image left-to-right. Note that in
portrait mode, this axis cuts through the narrower sides, while in landscape mode,
it cuts through the wider sides.

Automatic Discrimination

The automatic discrimination feature is useful when scanning documents
containing both photos and text. This feature allows the scanner to switch
between text and photo mode in one pass. Line mode scanning is binary and
photo mode is dithered halftone. The end result is that line art and photos are both
processed for their best appearance. The automatic discrimination feature
analyzes the reflected light from the page to determine if it is black and white
(very high or low signal) or gray scale (varying signal). When high signal
fluctuations are detected, the scanner switches to line mode for black and white.
When fluctuations are gradual, the scanner switches to halftone mode for
scanning a photograph.

Outline Extraction

The Outline feature saves the outline of a black and white image. The scanner
looks for the boundaries between black and white and connects them to form
outlines of the objects in the image.

Edge Emphasis

The edge emphasis feature enhances the edges of the image to make them appear
sharp and crisp. It can also be set to “smoothing” to help eliminate spot noise and
voids.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Hewlett-Packard Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• ScanJet IIC

• ScanJet IICX

• ScanJet 3C

• ScanJet 4C

• ScanJet 2P

• ScanJet 3P

• ScanJet 4P

• ScanJet 5P (without “green button” support)

• ScanJet 6100C

• ScanJet 6200C

• ScanJet 6250C

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
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Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 50, 60, 72, 75, 80, 90, 100,
120, 144, 150, 160, 180, 200, 240, 300, 320, 360, 400, 480, 600, 800, and
“other...”.

Figure 0-10  Hewlett-Packard Scanners
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Bits Per Pixel

Four levels of bits per pixel are offered: 1 bit/pixel for black and white, 4or 8
bits/pixel for gray scale, and 24 bits/pixel for color.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Contrast

The contrast slider bar allows you to vary the image contrast. Sliding it to the
right increases the contrast.

Auto Background

Auto Background is an image enhancement feature only available on
Hewlett-Packard scanners. This function adjusts the variations in the background
to even out the foreground.

Auto Document Feeder

If the ADF is installed, its checkbox will appear “solid.” When available, clicking
on this checkbox alternately enables and disables use of the ADF for scans.

If you try to scan with the ADF selected but have no paper inserted in the ADF,
an error message will appear at the bottom of your image display window. The
Preview function is disabled when the scanner is in ADF mode.

Zoom X, Zoom Y

Entering percentage values in these controls lets you change the magnification of
the scanned image, while preserving the DPI value. For example, choosing a
value of 200% along a particular direction will cause twice as many pixels to be
used to represent the same length, so that at a constant DPI, that image will be
twice as long in that direction.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• letter
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• legal

• B5

• A5

• A5 (land)

• A4

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Horizontal Mirror

This option allows you to do a scan which mirrors the image over a vertical axis
down the center of the image, thus reversing the image left-to-right. Note that in
portrait mode, this axis cuts through the narrower sides, while in landscape mode,
it cuts through the wider sides.

Figure 0-11  Hewlett-Packard Scanner Options
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Filtering

Image filtering has the effect of smoothing the image, as local clusters of pixels
are averaged.

Dithering

Dithering can help make a black-and-white scan represent gray images. It does
this by varying the size of clusters of black pixels. When viewed at arm’s length,
the dots blur, and the resulting image appears to have gray tones.

The list of available dither patterns depends on the particular scanner selected.
For this scanner, the following are available:

• none

• Coarse Fatting

• Fine Fatting

• Bayer Dither

• Vertical Line

The larger the pattern area, the more gray levels that can be represented, but with
a grainier result. Dither patterns can also be downloaded to achieve special
effects.

Matrix Coefficient

Selection of matrix coefficients lets you slightly alter the colors of scanned
images, so that the colors of the image on the final output device correspond more
closely to those of the original scanned image.

Tone Map

Setting of the tone map is an image enhancement feature of the Hewlett-Packard
scanners.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Microtek Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• ScanMaker 600ZS

• ScanMaker II

• ScanMaker IIXe

• ScanMaker IIHR

• ScanMaker III

• ScanMaker E3

• ScanMaker E6

• AGFA Arcus II

• AGFA DuoScan

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
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Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 60, 90, 120, 150, 180, 240,
300, 450, 600, 900, 1200, and “other...”.

Figure 0-12  Microtek Scanners
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Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white, 8
bits/pixel for gray scale, and 24 bits/pixel for color.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Contrast

The contrast slider bar allows you to vary the image contrast. Sliding it to the
right increases the contrast.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• B5

• A5

• A5 (land)

• A4

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Dithering

Dithering can help make a black-and-white scan represent gray images. It does
this by varying the size of clusters of black pixels. When viewed at arm’s length,
the dots blur, and the resulting image appears to have gray tones.

The list of available dither patterns depends on the particular scanner selected.
For this scanner, the following are available:

• none

• 8x8 53 grays

Figure 0-13  Microtek Scanners Options
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• 8x8 65 grays

• 8x8 33 grays

• 6x6 29 grays

• 5x5 26 grays

• 4x4 17 grays

• 3x3 10 grays

• 2x2 5 grays

The larger the pattern area, the more gray levels that can be represented, but with
a grainier result. Dither patterns can also be downloaded to achieve special
effects.

Shadow, Midtone, and Highlight

These sliders can be used to enhance the dynamic range of the images you scan.
If you have an image with lots of midtones that you would like to differentiate,
these controls can help. They allow you to specify the resolution of gray tones at
particular intensity levels, which in turn affects the overall brightness of the
image.

Shadow adjusts the level of the darkest dark for scanning. Below this value, all
pixels will be black.

Accordingly, Highlight allows you to bring down the top end of the range into
the midtones.

Midtone lets you set the intensity level corresponding to medium gray.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Panasonic Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• KVSS-50

• KVSS-55

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.

Figure 0-14  Panasonic Scanners
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Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are normally available: 200, 240, 300, and 400. 

Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white and 8
bits/pixel for gray scale.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Threshold

The threshold slider bar allows you to select the level, below which all pixels are
set to black, and above which all pixels are set to white. Moving the slider bar
setting to the right increases this threshold level.

Auto Document Feeder

If you try to scan with the ADF selected but have no paper inserted in the ADF,
an error message will appear at the bottom of your image display window. The
Preview function is disabled when the scanner is in ADF mode.

Certain pre-defined document sizes are supported by the ADF when it is
installed:

• letter (port and land)

• legal (port)

• 11” x 17”

• A5 (port and land)

• A4 (port and land)

• A3 (port)
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• B5 (port and land)

• B4 (port)

“port” is short for portrait mode, which orients the paper with the narrower side
on top. Portrait is the default setting.

“land” is short for landscape mode, which orients the paper with the wider side
on top.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

• letter

• letter (land)

• legal

• 11” x 17”

• B5

• B5 (land)

• B4

• A5

• A5 (land)

• A4

• A4 (land)

• A3

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Dithering

Dithering can help make a black-and-white scan represent gray images. It does
this by varying the size of clusters of black pixels. When viewed at arm’s length,
the dots blur, and the resulting image appears to have gray tones.

The list of available dither patterns depends on the particular scanner selected.
For this scanner, the following are available:

• None

• Photographs 1

• Photographs 2

• Characters/Photos 1

• Characters/Photos 2

Figure 0-15  Panasonic Scanner Options
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Gamma

Through the Gamma control, you can adjust the light intensity scale between the
original image and output image so that when the image is reproduced on some
devices, the tones in the reproduced image may be closer to those in the original
image.

Compression

When built-in compression hardware is present, this control allows you to select
the type of compression that will be recorded in the image’s Settings file, for use
when scanning directly to a file. Note that images scanned to a displayed window
will not be compressed.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Horizontal Mirror

This option allows you to do a scan which mirrors the image over a vertical axis
down the center of the image, thus reversing the image left-to-right. Note that in
portrait mode, this axis cuts through the narrower sides, while in landscape mode,
it cuts through the wider sides.

Edge Emphasis

The edge emphasis feature enhances the edges of the image to make them appear
sharp and crisp. It can also be set to “smoothing” to help eliminate spot noise and
voids.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Ricoh Scanners 

SCANNER MODELS SUPPORTED INCLUDE:

• Aficio IS-01

• FS-2

• IS-50

• IS-60

• IS-410

• IS-420

• IS-430

• Digital Equipment Corp. MD-410

• IBM 2456

• Bell & Howell 500 FB, 1000 FB, and 1500 FB

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
154 - OCR Shop User’s Guide



Appendix A:Scanner and Printer Specific Features
Scanner Selection

The Scanner menu shows the scanners that are available. If you have no scanners
available, then this fact will be indicated. The last item on this list is always
“show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 50, 60, 72, 75, 80, 90, 100,
120, 144, 150, 160, 180, 200, 240, 300, 320, 360, 400, 480, 600, 800, 1200, and
“other...”.

Figure 0-16  Ricoh Scanners
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Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white, and 4 or
8bits/pixel for gray scale.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Contrast

The contrast slider bar allows you to vary the image contrast. Sliding it to the
right increases the contrast.

Threshold

The threshold slider bar allows you to select the level, below which all pixels are
set to black, and above which all pixels are set to white. Moving the slider bar
setting to the right increases this threshold level.

Auto Document Feeder

The Automatic Document Feeder (ADF) is an option on IS50 and IS60 scanners
(part number DF-60) and comes standard on the model IS410. The ADF
checkbox is located under the Threshold slider bar. If your scanner has an ADF,
it will be selectable.

If you try to scan with the ADF selected but do not have paper inserted in the
ADF, an error message will appear at the bottom of your image display window.
The Preview function is disabled when the scanner is in ADF mode.

Document Size

All three Ricoh scanners allow manual input of document size, but the
pre-defined document sizes are different for the IS50/IS60 and the IS410. The
abbreviated menu button for the IS50 and IS60 displays are as follows:

• letter

• legal

• A5

• A5 (land)
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• A4

• B5

The abbreviated menu button for the IS410 displays:

• letter

• letter (land)

• legal

• 11” x 17”

• A5

• A5 (land)

• A4

• A4 (land)

• A3

• B5

• B5 (land)

• B4

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Horizontal Mirror

This option allows you to do a scan which mirrors the image over a vertical axis
down the center of the image, thus reversing the image left-to-right. Note that in
portrait mode, this axis cuts through the narrower sides, while in landscape mode,
it cuts through the wider sides.

Dithering

Dithering can help make a black-and-white scan represent gray images. It does
this by varying the size of clusters of black pixels. When viewed at arm’s length,
the dots blur, and the resulting image appears to have gray tones.

The larger the pattern area, the more gray levels that can be represented, but with
a grainier result. Dither patterns can also be downloaded to achieve special
effects.

Figure 0-17  Ricoh Scanner Options
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Compression

When built-in compression hardware is present, this control allows you to select
the type of compression that will be recorded in the image’s Settings file, for use
when scanning directly to a file. Note that images scanned to a displayed window
will not be compressed.

Line Art Filtering

All of the line art filtering options work only with 1 bit/pixel images (line art,
black and white images).

• None

No filtering will be done.

• Bold Lining

This removes single black dots, extracts edges, thickens edges.

• Edge Detection

This looks for the boundaries between black and white and connects them to
form outlines of the objects in the image.

Smoothing

Smoothing softens the transition between black and white by creating the illusion
of gray.

Speckle Removal

Speckle removal eliminates extraneous dots in the image.

Image Filtering

• None

This will disable filtering of images.

• Averaging

Choosing this option averages 2x2 neighborhoods of pixels together to
achieve a “smoothing” effect.

• MTF
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This is a filter for boosting fine lines, and thus is effective when black and
white line art is scanned.

Ricoh Gamma Tables

You can download a desired gamma table or you can choose one of the following:

• Normal

This option gives output closest to the original document.

• Smooth

This creates an overall loose, soft feeling.

• Sharp

This option emphasizes the border line between black and white.

• Linear

With this option, scanned pixel values are passed through the gamma unit
unchanged.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Sharp Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• JX-320s (SCSI)

• JX-330 (SCSI)

• JX-600  (GPIB and SCSI)

• JX-610 (SCSI)

SCANNER SETUP

The OCR Shop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. OCR Shop automatically enables the controls
which are applicable to your scanner.
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For GPIB operation, OCR Shop requires that a National Instruments GPIB
adapter be installed with its GPIB drivers.

Scanner Selection

The Scanner menu shows the scanners that are available. If you don’t have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

The following choices of dpi are typically available: 50, 60, 72, 75, 80, 90, 100,
120, 144, 150, 160, 180, 200, 240, 300, 320, 360, 400, 480, 600, 800, 1200, and
“other...”. 

Figure 0-18  Sharp Scanners
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Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white,
8bits/pixel for gray scale, and 24 bits/pixel for color.

Transparency Illumination Unit

The Sharp JX-600 and JX-610 scanners ship with a transparency illumination
unit. Use of this unit is supported in OCR Shop automatically when it is installed
and connected each time when you start OCR Shop.

Threshold

The threshold slider bar allows you to select the level, below which all pixels are
set to black, and above which all pixels are set to white. Moving the slider bar
setting to the right increases this threshold level.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Emphasis

The edge emphasis feature enhances the edges of the image to make them appear
sharp and crisp. Four degrees of emphasis are available: None, Dull, Medium,
and Strong.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered for the JX-600 and JX-610 (the JX-320S and document
sizes are a subset of this list):

• letter

• letter (land)

• legal

• 11” x 17”

• B5

• B5 (land)
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• B4

• A5

• A5 (land)

• A4

• A4 (land)

• A3

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
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SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Gamma

Through the Gamma control, you can adjust the light intensity scale between the
original image and output image so that when the image is reproduced on some
devices, the tones in the reproduced image may be closer to those in the original
image.

Figure 0-19  Sharp Scanner Options
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Load Media

Load Media (JX-600 and JX-610) is used to help you position the platen of the
scanner when the overhead transparency unit is installed. Select “Left” to slide
the platen clear of the transparency unit for loading of your image media. Select
“Center” to re-position the platen in the normal position for scanning.

Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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UMAX Scanners

SCANNER MODELS SUPPORTED INCLUDE:

• PowerLook 2000

• Mirage D-16L

• MD 1600

• Vista S-12

• Super Vista S-12

SCANNER SETUP

The ScanShop Scanner Setup window provides controls for the scan area,
resolution, and other settings. Many of the controls are available for all scanners,
while others are model-specific. ScanShop automatically enables the controls
which are applicable to your scanner.
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Scanner Selection

The Scanner menu shows the scanners that are available. If you don't have any
scanners available, then this fact will be indicated. The last item on this list is
always “show all devices”.

Dots Per Inch

Choices of dpi from 50 to 800 are available from the pull-down menu. You can
select “other” to specify a higher dpi.

Figure 0-20  UMAX Scanners
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Bits Per Pixel

Three levels of bits per pixel are offered: 1 bit/pixel for black and white,
8bits/pixel for gray scale, and 24 bits/pixel for color.

Brightness

The brightness slider bar varies the brightness of the image, ranging from darkest
on the left to lightest on the right.

Contrast

The contrast slider bar allows you to vary the image contrast. Sliding the bar to
the right increases the contrast.

Threshold

The threshold slider bar allows you to select the level, below which all pixels are
set to black, and above which all pixels are set to white. Moving the slider bar
setting to the right increases this threshold level.

Transparency Unit

If you have a transparency unit on your scanner, you can toggle the transparency
unit option to turn it on or off.

Document Size

In selecting the size of the area to be scanned, the following standard document
sizes are typically offered:

    letter 

    letter (land) 

    legal 

    11" x 17" 

    B5 

    B5 (land) 

    B4 

    A5 
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    A5 (land) 

    A4 

    A4 (land) 

    A3 

All document sizes are in portrait mode (narrower side on top), unless indicated
by a “land” designation.

X0, Y0, Width, Height

The document size may also be set manually, either by dragging a rectangle in
the preview area or by entering the settings directly into the X0, Y0, Width, and
Height text fields. The setting units may be specified as Inches, Millimeters, or
Pixels (“Pels”).
170 - OCR Shop User’s Guide



Appendix A:Scanner and Printer Specific Features
SCANNER SETUP OPTIONS

This window provides access to scanner-specific settings.

Photo Invert

Selecting this control will let you scan the “negative” of your images.

Gamma

Through the Gamma control, you can adjust the light intensity scale between the
original image and output image so that when the image is reproduced on some
devices, the tones in the reproduced image may be closer to those in the original
image.

Figure 0-21  UMAX Scanner Options
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Scanner Reports

This is a small text display area that shows information about the scanner you are
using. Information here will include ROM version information and other
information that particular scanner models report about themselves.
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Overview

This chapter offers some troubleshooting hints as well as brief pointers to
maximize operation efficiency.

Getting Help

Read this section of the manual

This section of the manual contains useful information on common problems and
troubleshooting. If you do not find an answer please go to our website’s support
section.

Submitting a Question to the Support Department

At the Vividata Website http://www.vividata.com you will see a link “Contact
Support”. Go to this page to fill out information and submit a support request.

Identifying the Problem

There are several status files and options you can set in OCR Shop XTR to help
you identify the cause of your problem.

Step 1: Verify Licensing is Working

Run vvlmstatus to check if the license manager daemon is running:

$VV_HOME/bin/vvlmstatus 

This command will display a list of the license keys you have installed and
number of licenses available for each key.  It also displays the license manager
process id and process name, if it is running.
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If you have never run Vividata software before, the license manager will not be
running.  This is normal.  The license manager is  started automatically the first
time you run OCR Shop XTR.

Try running OCR Shop XTR to start the license manager, then run vvlmstatus
again.  If the license manager is still not running or shows errors, verify that a
license key is installed on your system.  The   file
$VV_HOME/config/license.dat contains your license key(s).  It should
be an ASCII text file with 644 permissions.  If it is not there, then your license
key has not been installed.  Install the license key via the distributed shell script,
or contact Vividata if you can not find your key or have questions.

If something still seems wrong with the license manager, set an environment
variable called VV_DEBUG to 1000 and then run OCR Shop XTR.  A large
amount of debug information will print to the console, including any error
messages regarding licensing.

If the license manager seems to be in a bad state, stop it by running the command
$VV_HOME/bin/vvlmstop.  Then verify that the license manager process is
no longer running using the ps command.  The license manager will start again
the next time you run OCR Shop XTR.

You may also need to restart the license manager.  For details, see “License
Manager Commands” on page 177.

Step 2: Check Log Files

Vividata software generates various log files that can be useful for determining
the cause of many problems.

vividata.log

When your system reboots, a file called vividata.log is created in the /tmp
directory. This file contains information from the license manager used with our
products. This log is useful in determining if licensing is starting at boot time
correctly.
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How to Get a License

Installing the Keys

To enter your license keys, use the Installer. Please see “Installing the License
Keys” on page 6. Then, try restarting OCR Shop XTR.

You must have a valid license before you can use PShop. If you haven’t yet
received a license key from us, you need to get one. You can get one by
contacting Vividata Support or Vividata Sales through our website
http://www.vividata.com, or by telephone or fax (see contact information at the
front of this manual).  If you are certain that you have a valid license, verify that
your licensing is set up correctly (See Appendix  C, “License Manager
Commands”, for license manager information.) 

Installing the Keys
PShop license keys are normally distributed within a shell script installer, named
“vvkey.sh” or something similar.  To install a key, run the script on the
command-line as root, “sh vvkey.sh”, and the license key will be placed in
$VV_HOME/config/vvlicense.dat.

Patches

It is suggested that the operating system be maintained by installing the most
current patches available from the platform vendor, as certain (possibly known)
bugs can affect the operation of OCR Shop XTR. Check Vividata’s release notes
and the support areas of our website for mention of any specific known problems
which can be fixed with certain patches.
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Manager Commands
Overview

Publicly distributed versions of Vividata products use a proprietary license
manager. This section will describe the usage of the license manager as it pertains
to Vividata products, including determining the lmhostid necessary for license
keys to be issued, diagnosing the license keys and license server, and additional
configuration information.

License Manager Utilities

You will find the various license manager utilities discussed below in the
$VV_HOME/bin directory after you have installed a Vividata product containing
the license manager. This set of utilities currently includes lmutil and six links to
this file: lmdiag, lmdown, lmhostid, lmremove, lmreread, and lmstat. The license
daemons, found in the same directory, are lmgrd and vv_d2.

The License Daemon

A license daemon runs in the background in order for the license manager to
operate properly.  The daemon is started automatically by the Vividata software
and the process is named either “vvlicense” or has the same name as the software
binary, depending on the system.  The user never starts the license manager or
daemon by hand.  If for some reason the license daemon needs to be stopped, the
“vvlmstop” utility (described below) should be used to stop the program
gracefully.

License File Format

The license file is plain text and contains a long encrypted string that encodes the
license(s).  Usually a short text string is concatentated to the right of the license
string, along with the serial number(s).  More than one license for the same
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product may be stored in one license key.  License keys for more than one
Vividata product may be included on separate lines in the same license file.

Obtaining your lmhostid

If you have a Vividata product installed on your system, you can simply run
“vvlmhostid” to determine the lmhostid on your system. If you need the lmhostid
prior to installing the software, or if the “vvlmhostid” utility does not return a
valid lmhostid, please see the following table to determine your lmhostid
manually.

Table 1: lmhostid derivations

Platform Source User command Example

OSF/1
Digital Unix

ethernet 
address

netstat -i 080020005532

HP-UX 32-bit hostid uname -i and convert 
to hex or prepend with 
#

778DA450 or 
#2005771344

Linux ethernet 
address

/sbin/ifconfig eth0 and 
remove colons from 
HWaddr

00400516E525

AIX 32-bit hostid uname -m then remove 
last 2 digits, and use 
remaining last 8 digits

02765131

IRIX 32-bit hostid /etc/sysinfo -s and 
convert to hex, or 
prepend with #

69064C3C or 
#1762020412

SunOS and 
Solaris

32-bit hostif hostid 170a3472
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Windows NT ethernet 
address

Programs: Administra-
tive Tools (common): 
Windows NT Diag-
nostics: Network: 
Transports:Address

Programs: 
Administrative 
Tools (common): 
Windows NT 
Diagnostics

Table 1: lmhostid derivations

Platform Source User command Example
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Command Reference

vvlmstat

NAME
vvlmstat – Displays the current status of the license manager.

SYNOPSIS
vvlmstatus

DESCRIPTION
vvlmstatus checks the current state of the license manager and reports how many
keys are available for each product for which you have a license key.
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vvlmstop

NAME
vvlmstop – Shuts down the license daemon

SYNOPSIS
vvlmstop

DESCRIPTION
vvlmstop shuts down the license manager process if it is running.
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vvlmhostid

NAME
vvlmhostid – Prints the lmhostid of the system

SYNOPSIS
vvlmhostid

DESCRIPTION
vvlmhostid prints the machine id (lmhostid) of the system, usually used for
generating license keys.
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vvlmreread

NAME
vvlmreread – Forces the license daemon to reread the license file

SYNOPSIS
vvlmreread

DESCRIPTION
vvlmreread causes the vendor daemon to reread the license file and update itself
on any new feature licensing information.
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Key Read program

NAME
<product>KeyRead – Utility that decodes the features from a license key; the
name varies with the product.

SYNOPSIS
<product>KeyRead -k [key string]

DESCRIPTION
The key read program permits you to view what options and licenses are encoded within
the license key string.  Pass the key string listed in your license file to the key read
program to verify the features, number of licenses, and product enabled by that key
string.
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Glossary term Term definition

ADF Automatic document feeder

ASCII An acronym for American Standard Code for Informa-
tion Interchange. A code in which the numbers from 0 
to 127 stand for text characters. ASCII code is used for 
representing text inside a computer and for transmitting 
text between computers or between a computer and a 
peripheral device.

auto segmentation The process in which the OCR Shop XTR determines 
where on a page different elements are such as where 
pictures are and where columns of text are.

binary image A image that is represented using only one bit per pixel. 
Such images are also called black and white, mono-
chrome, bi-level, or 1-bit.

bit-mapped image A collection of bits (dots) in memory that represent the 
scanned image. The display on the screen is a visible 
bit-mapped image.

Code Page “Code Page” is a Microsoft® term. A code page is a 
particular mapping of a set of unsigned bytes to a set of 
visible characters (and space characters). Different 
code pages are used to represent in memory the charac-
ters in different languages. See 
http://www.microsoft.com/globaldev/reference/ 
WinCP.asp for more details.
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compound
document

A compound document is a set of one or more pages 
that consists of a mixture of text and images, for exam-
ple pdf or html.

conversion
filter

A program that translates one file format into another. 
For example, the ‘mpage’ conversion filter can translate 
an ASCII file into a PostScript file.

device driver A program that manages the transfer of information 
between the computer and a peripheral device such as a 
scanner.

digital image A digital image is the way a picture or visual image of 
some object is represented in computer memory. A dig-
ital image consists of a number of pixels and a descrip-
tion of how the pixels are arranged to form the image. 
In addition, information about how each pixel stores 
the color of the original image is included.

dithering A method of representing an image using fewer colors 
than the image actually has.

document A document is a set of pages that are related usually 
because the sense of the text on one page flows into the 
next as in a book. For OCR Shop XTR, it is best to 
arrange for documents to be sets of pages that have the 
same font or set of fonts continuing from one page to 
the next. This best takes advantage of the internal font 
learning system that is built into the OCR Shop XTR 
recognition system.

dpi An abbreviation for dots per inch. This is the number of 
dots per linear inch that a printer can print or a scanner 
can produce. See also resolution.

driver See device driver

Glossary term Term definition
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frame A frame is a way to represent the maximum extent of 
some page element in the horizontal and vertical direc-
tion (X and Y coordinates respectively). A frame can be 
thought of as a rectangle that is lined up with the X and 
Y axes. Frames are represented by four numbers, which 
can be top, left, bottom, right or top, left, height, width. 
Also see UOR.

language pack A language pack is a data file supplied with the OCR 
Shop XTR that includes information about how the 
characters of a given language are put together to write 
words and sentences in the language. Language packs 
contain information about the common words used in a 
language, rules for punctuation and the conventions 
used when writing things such as numbers, money 
amounts and dates.

language set A language set is that set of supported languages that 
can be recognized with a given shape pack loaded. 
Each of the supported languages in a language set may 
or may not have an available language pack associated 
with it. Languages without an available language pack 
can still be recognized but accuracy for these languages 
will not be as high as for languages for which a pack 
exists

lexical constraints A lexical constraint is a set of restrictions on how the 
characters on a given page or region within a page can 
be recognized. Constraints can include the set of lan-
guages allowed, and/or a character set that recognition 
is restricted to. A lexical constraint can be a weaker 
preference or a stronger absolute. A custom word list 
can be used as an additional lexical constraint on the 
recognition.

Glossary term Term definition
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lexicon A lexicon is a list of words used in a given language 
and perhaps in a special setting. Language packs sup-
plied with OCR Shop XTR contain built in general pur-
pose lexicons. Users may specify a custom lexicon with 
the user_lexicon parameter.

monospaced font Any font in which all characters have the same width. 
For example, in Courier New (a monospaced font), the 
letter “M” is the same width as the letter “l”. Thus, 
“MMMMM” is the same width as “lllll”.

orient To orient a page is to rotate the page in memory so that 
it is better positioned for display to the user and/or rec-
ognition by the OCR Engine. A page is oriented for 
recognition when the text flows left to right (from low 
X to high X coordinates) and from top to bottom (lowY 
to high Y coordinates).

page A page is the unit that makes up a document. Within 
OCR Shop XTR, a page is usually the representation of 
one side of a single piece of paper if that was input 
from a scanner. In addition it may be a single image, 
input from a file, fax machine, digital camera or other 
digital image input device. For purposes of licensing, a 
page size equivalent to a US letter size or ISO A4 is 
used.

peripheral At or outside the boundaries of the computer itself, 
either physically (as a peripheral device) or logically 
(as a peripheral card). 

Glossary term Term definition
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pixel Pixel is short for picture element. A point (dot) on the 
graphics screen. It is the smallest definable unit of a 
digital image. Each pixel represents a single point in 
the image. The number of pixels per unit distance 
(dot-per-inch or DPI for instance) within a digital 
image is referred to as the resolution of the image. A 
pixel can be binary, gray, or color, or can be an index 
into a palette. Binary pixels require only one binary 
digit or bit of computer memory to store; gray, color 
and indexed pixels use more bits with 4, 8, and 24 
being common values for the number of bits used.

point A typographic unit of measurement equal to 1/72 inch, 
measured vertically. Points are used to describe font 
size.

proportional font Any font in which characters differ in width. For exam-
ple, in the proportional font used here, the letter “M” is 
wider than the letter “l”. Thus, “MMMMM” is wider 
than “lllll.”

rdiff file In OCR Shop XTR a file which contains descriptions of 
the image and text regions of a document image.

recognize In the context of the OCR Shop XTR, when an image is 
recognized, it is processed using the OCR Engine that 
is part of the OCR Shop XTR. During this process the 
pixels making up a digital image are processed by the 
OCR engine to determine which pixels are parts of vis-
ible text characters within the image. The identities of 
those characters are also determined and stored in 
memory using the code page representation of the 
given character. The result of recognition is used to cre-
ate output based on the user settings.

Glossary term Term definition
OCR Shop XTR User’s Guide - 189



Appendix D:Glossary
region A region is an area of a page that usually contain either 
all text or all picture. Regions can be determined by the 
OCR Shop XTR during auto-segmentation or specified 
by a user in an rdiff input file.Regions on a page can 
overlap. Regions can be simple rectangles in shape or 
they can be more complex (see UOR). 

resolution The fineness with which a scanner, printer, or other 
device produces information. It is expressed in dots per 
inch (dpi). A higher dpi produces a sharper image.

shape pack A shape pack is a data file supplied with the OCR Shop 
XTR that describes the shapes of the characters that can 
be recognized by the OCR engine when that shape pack 
is loaded. Each shape pack corresponds to a particular 
code page that will be used for output when that shape 
pack is loaded. For each shape pack there is an implied 
language set that represents the supported languages 
that can be recognized with that shape pack loaded.

skew Skew is the amount of tilt in an input image.Skew is 
generally used to describe the tilt in images including 
text. In such images the tilt is more apparent and affects 
recognition and layout analysis.

swap file An area of the hard disk that is used for temporary data 
storage when RAM is low or used up. This is also 
known as virtual memory. A swap file lets you run 
more programs than you could with actual memory, but 
it is slower than using regular memory. 

text file A file containing information in text form; its contents 
are interpreted as characters encoded using the ASCII 
(or comparable) format.

TIFF An abbreviation for tagged image file format. This is a 
standard graphic file format for grayscale and high-res-
olution bit-mapped images.

Glossary term Term definition
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TrueType™ fonts One of the major types of scalable fonts. These can be 
printed or displayed on the screen at any size. 

Unicode UNICODE is a standard for representing visible char-
acters using a stream of bytes in computer memory or 
on some other digital storage medium. Unlike code 
pages where each code page can only be used to 
describe a subset of the known written languages, Uni-
code is a single standard way to represent all of the 
world's common written languages. Whereas the code 
page representation uses a single byte to represent each 
character, Unicode uses a 16-bit word for each charac-
ter. The OCR engine that is part of OCR Shop XTR 
does recognition internally based on a single selected 
code page. During output however, the text data can be 
converted to Unicode for use with other applications 
that expect text data in Unicode format.

UOR (Union of 
Rectangles)

A UOR or Union Of Rectangles is the data used to rep-
resent the position and shape of a region in a region 
descriptor. A UOR is a list of rectangles contained in an 
rdiff file. The area described by the UOR is the sum or 
OR-ing of all the areas described by each rectangle in 
the list.

zone See Region.

Glossary term Term definition
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Index
Numbers

3D OCR 108

A

Activity Log 56
ADF. see Automatic document feeder 185
AGFA

Arcus II See Microtek Scanners
DuoScan See Microtek Scanners

AnyFax 107
AnyFont 105
AnyPage 107
areas of text recognition 37
ASCII 2, 185
Auto Detect Mode 72
Auto Generate Output File Suffixes 86
Auto Save Graphic Blocks 86
Auto Save Text without Editing 85
auto segmentation 185
auto text layout 72
Automatic Document Feeder (ADF) 80
Automatic Recognition 58
Automatic Zones 71

B

Batch Scan 59
ADF 62
BPP 62
Document Size 62
DPI 62
Filenames 59
Grouping 61
Image Directory 60
Image Filename(s) 60

Image Format 61
Image ID 61
Image Suffix 61
Overwrite File Protection 62
Sample 30
Scanner Set-up 62
Window 60

Bell & Howell Scanners 109
1000 FB See Ricoh IS-420.
1500 FB See Ricoh IS-430.
500 FB See Ricoh Aficio IS-01.
Copiscan 4000 series 109
Copiscan 8000 series 109
Copiscan II series (e.g. 3338A, 6338A) 109

binary image 185
bit-mapped image 185
Bits per pixel

About 78
Blank Page is Document Separator 61, 85
Brightness

About 79

C

Canon Scanners 115
CJ/CLC-10 with IPU-SS (scan and print) 115

Character Experts 105
character image 34
characters 31
Code Page 185
column Selection 40
complex page layouts 71
compound document 186
Compound Neural System 107
Contacting Customer Support 4
conversion 186
conversion filter 186
Custom Zone Contents 96
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D

delete selected file 69
device driver 186
dictionaries 24
different column layouts 72
Digital Equipment Corp.

MD-410 See Ricoh IS-410.
digital image 186
display listing of jobs 56
disregard formatting 72
dithering 186
Doc number 73
document 186

compound 186
name 73
quality 14
size 80
specification window 84
specification... 74
type 53

doodles 14
Dots per Inch

About 78
Double-sided Documents 61, 84
dpi 186
driver 186
duplex scanner 61

E

Environment Variables
in general 7

Epson Scanners 123
Action Scanner II 123
ES-X000C scanners 123
Expression 636 123
Expression 800C 123
Expression 836XL 123
GT-X000 scanners 123

F

file
including page numbers 73

rdiff 189
size 79
swap 190
text 190

File Menu 44
Exit 46
Load Settings... 44
Save Settings 45
Save Settings As... 45

font
monospaced 188
proportional 189
TrueType™ 191

Foreign Languages 16
frame 187
Fujitsu Scanners 130

ScanPartner 10 130
ScanPartner 10C 130
ScanPartner M3096G+/m 130
ScanPartner M3096Gx 130
ScanPartner M3097G 130
ScanPartner M3099G Duplex scanner 130

G

Getting Help 173
Grouping 84

H

Help Menu 55
Product Information 55
Show Activity Log 56

Hewlett-Packard Scanners 138
ScanJet 2P 138
ScanJet 3C 138
ScanJet 3P 138
ScanJet 4C 138
ScanJet 4P 138
ScanJet 5P 138
ScanJet 6100C 138
ScanJet 6200C 138
ScanJet 6250C 138
ScanJet IIC 138
ScanJet IICX 138
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I

IBM 2456 See Ricoh IS-410.
image

Directory 87
file 18
Format 87
size 81
Suffix 87
Viewer 65

image processing
extended features 75

Improving
Accuracy 13
Speed 13

Installation 6
See Chapter 2 5

Interactive Recognition 58

L

language
character selection 46
pack 187
set 187

Language Analyst 108
languages 23
Large Jobs 16
Legal Documents 15
Lexical Assist 54
lexical constraints 187
lexicon 188
licensing

problems 175
Line Art 14
load saved settings 44

M

manual on Netscape 55
Microtek Scanners 144

ScanMaker 600ZS 144
ScanMaker E3 144
ScanMaker E6 144
ScanMaker II 144

ScanMaker IIHR 144
ScanMaker III 144
ScanMaker IIXe 144

Multilingual Document 16
multiple

columns 72
graphics 71

Multiple Pages -> Single Document 73

N

naming customized document 73
netremote script 52
No Parsing 72

O

obtaining scanner images 70
OCR

manual zone 14
pointers 14
run manually 13

OCR. See Optical Character Recognition
OmniPage OCR Technologies 105
one column 72
On-Line Help 55
Optical Character Recognition 1

General Description 2, 104
Technologies 105

Options Menu 46
Languages 46
Recognition Options 53
Trained Character Settings 50

orient 188
Orientation 54
Ouput Format Editor dialog 54
Overview 1
Overwrite Protection 85

P

page 188
Page Analysis 105
Page number 73
Panasonic Scanners 149
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KVSS-50 149
KVSS-55 149

Paper Transparency 15
patches 175
PATH 12
peripheral 188
pixel 189
Pleading Papers 15
point 189
Preview scan

About 81
previously saved image 69
Product Information 55
Proofing Editor 65
proofing editor list 52

Q

quit OCR Shop 46

R

rdiff file 189
recognition accuracy 13
Recognition Mode 53
Recognition Settings 53

Area to Recognize 71
Column Selection 72
Document Selection 73
Image Source 68
Output filenames 73
Retain Formatting 72
Window 68

recognize 189
region 190
reject character 52
Removing OCR Shop 7
resolution 190

scan 78
retaining original format 72
Ricoh Scanners

Aficio IS -01 154
FS-2 154
IS-410 154
IS-420 154

IS-430 154
IS-50 154
IS-60 154

rotate images 54

S

save as settings 45
Save Image(s) of Whole Document 21, 86
saved session settings 12
scanner

controls 76
glass clarity 15
preview 76
Set-up Window 75, 76

scanners
standard features 75

Scanning Angle 14
ScanSoft i
Scansoft 2
SCSI

Show All Devices option 77
Self-Learning OCR 106
settings 12
Setup Dialog

Automatic Document Feeder (ADF) 80
Bits per Pixel 78
Brightness 79
Document Size 80
Dots per Inch 78
Image Size 81
Options 82
Preview 81
Scanner 77
Threshold 79

shape pack 190
Sharp Scanners 161

(GPIB/SCSI) 161
JX-320s 161
JX-330 161
JX-600 161
JX-610 161

simple page layout 71
simplex scanner 61
Single Column/Table 72
skew 190
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Specific Zones 71
Spreadsheets

Scanning 16
suffix 21

.rc. 27
system requirements 3

T

Tables
Scanning 16

tech support.See Contacting customer support
Text Directory 86
Text Format 86
Text Format menu 54
Text Suffixes 86
Threshold

About 79
TIFF 190
Toolbar 58
Train Characters

Append... 102
Cancel 102
Delete 101
Save... 102
Specify... 100
Window 100

Trained Character File 63, 64
Editing 64

training files 50
Training Session 63
Trigram Analysis 108
troubleshooting hints 173
type conventions 3

U

UMAX Scanners 167
MD 1600 167
Mirage D-16L 167
PowerLook 2000 167
Super Vista S-12 167
Vista S-12 167

Unicode 191
UOR (Union of Rectangles) 191

Use Page Numbers 61
User Dictionary 47

editing 49
user-accessible buttons 18

V

vividata.log 174

W

Whole Page 71

Z

zone 191
Zone Editor

1:1 93
180 Rotation 93
90 Clockwise 93
90 Counter-clockwise 93
Cancel 98
Clear Zones 98
Column Selection 95
Continue 98
Custom Zone Contents 96
Delete 94
Draw 95
Edit Menu 92
File Menu 91
Fit to Window 93
Load Background Image... 92
Load Zone File... 91
No Rotation 93
Number 94
Rotate Menu 93
Save Zone File As... 92
Undo 92
Undo All 92
When to Use 91
Window 90
Zone Contents 95
Zoom In 93
Zoom Menu 93
Zoom Out 93
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